Email Guide
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email</strong></td>
<td></td>
</tr>
<tr>
<td>Email Campaigns</td>
<td>5</td>
</tr>
<tr>
<td>Create Campaigns</td>
<td>6</td>
</tr>
<tr>
<td>Create Efforts</td>
<td>6</td>
</tr>
<tr>
<td>Templates</td>
<td>7</td>
</tr>
<tr>
<td>Mobile Friendly Email Templates</td>
<td>15</td>
</tr>
<tr>
<td>Template Data Sources</td>
<td>16</td>
</tr>
<tr>
<td>Add Conditional Content</td>
<td>20</td>
</tr>
<tr>
<td>Preview Conditional Content</td>
<td>23</td>
</tr>
<tr>
<td>Messages</td>
<td>29</td>
</tr>
<tr>
<td>View sent email statistics</td>
<td>32</td>
</tr>
<tr>
<td>Bounced Email Management</td>
<td>38</td>
</tr>
<tr>
<td>Email Delivery Status</td>
<td>43</td>
</tr>
<tr>
<td>Newsletters</td>
<td>44</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>45</td>
</tr>
<tr>
<td>Notifications</td>
<td>53</td>
</tr>
<tr>
<td>Lists</td>
<td>58</td>
</tr>
<tr>
<td>Test Lists</td>
<td>66</td>
</tr>
<tr>
<td>Invalid Accounts</td>
<td>74</td>
</tr>
<tr>
<td>eCard Templates</td>
<td>75</td>
</tr>
<tr>
<td>Sample eCard Templates</td>
<td>76</td>
</tr>
<tr>
<td>eCard Template Merge Fields</td>
<td>86</td>
</tr>
<tr>
<td>eCard Email Message Merge Fields</td>
<td>87</td>
</tr>
<tr>
<td>Scheduled Emails</td>
<td>88</td>
</tr>
<tr>
<td><strong>Email Delivery and Deliverability</strong></td>
<td>88</td>
</tr>
<tr>
<td>Blackbaud's Role in Delivery</td>
<td>91</td>
</tr>
<tr>
<td>External Blacklists</td>
<td>91</td>
</tr>
<tr>
<td>Suppression Lists</td>
<td>93</td>
</tr>
<tr>
<td>Shared IP Addresses</td>
<td>95</td>
</tr>
<tr>
<td>Client's Role in Deliverability</td>
<td>93</td>
</tr>
<tr>
<td>List Quality</td>
<td>94</td>
</tr>
<tr>
<td>Engaged Recipients</td>
<td>97</td>
</tr>
</tbody>
</table>
# Email

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Campaigns</td>
<td>6</td>
</tr>
<tr>
<td>Create Campaigns</td>
<td>6</td>
</tr>
<tr>
<td>Create Efforts</td>
<td>7</td>
</tr>
<tr>
<td>Templates</td>
<td>15</td>
</tr>
<tr>
<td>Mobile Friendly Email Templates</td>
<td>16</td>
</tr>
<tr>
<td>Template Data Sources</td>
<td>20</td>
</tr>
<tr>
<td>Add Conditional Content</td>
<td>23</td>
</tr>
<tr>
<td>Preview Conditional Content</td>
<td>29</td>
</tr>
<tr>
<td>Messages</td>
<td>32</td>
</tr>
<tr>
<td>View sent email statistics</td>
<td>38</td>
</tr>
<tr>
<td>Bounced Email Management</td>
<td>43</td>
</tr>
<tr>
<td>Email Delivery Status</td>
<td>44</td>
</tr>
<tr>
<td>Newsletters</td>
<td>45</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>53</td>
</tr>
<tr>
<td>Notifications</td>
<td>58</td>
</tr>
<tr>
<td>Lists</td>
<td>66</td>
</tr>
<tr>
<td>Test Lists</td>
<td>74</td>
</tr>
<tr>
<td>Invalid Accounts</td>
<td>75</td>
</tr>
<tr>
<td>eCard Templates</td>
<td>76</td>
</tr>
<tr>
<td>Sample eCard Templates</td>
<td>86</td>
</tr>
<tr>
<td>eCard Template Merge Fields</td>
<td>87</td>
</tr>
<tr>
<td>eCard Email Message Merge Fields</td>
<td>88</td>
</tr>
<tr>
<td>Scheduled Emails</td>
<td>88</td>
</tr>
</tbody>
</table>

*Email* contains *Messages, Newsletters, Templates, Lists, Acknowledgements, eCards templates, Invalid accounts, Campaigns, and Notifications*. When you create an email message in the program, you first create an email template. Next, you create the list of email recipients. Lastly, you select the type of email to send: message, newsletter, or acknowledgement.

**Tip:** For best practice information about email, refer to [Blackbaud Email Delivery Best Practices](#).
In *Invalid accounts*, you can view email address accounts reported as “invalid” by their host Internet Service Provider (ISP). For example, an ISP may report an email address account as invalid due to a nonexistent or canceled account. Typical causes of an invalid account occur when the email address contains a typographical error or the email account is canceled due to inactivity.

When you host multiple sites, you can create email for individual sites. To do this, log in to the site and create the email. For more information, see the *Administration Guide*.

*Show Me:* Watch an overview of the email process.

## Email Campaigns

In *Campaigns*, you can create campaigns using email sent to targeted lists. For example, during tax season, your organization asks its members to donate their tax refunds to help buy food for rescued animals living in a shelter. You can create a series of email messages that are tailored for specific audiences. With A/B split testing, you can identify the messages that are most effective for each email list.

### Create Campaigns

Campaigns records store related email efforts and their associated email lists and messages. You can create multiple campaign folders to organize related email campaigns.

**Create an email campaign**

1. From *Email*, click *Campaigns*. *Campaigns* appears.
2. Click *New campaign*. The New Email Campaign screen appears.

### Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. In the *Name* field, enter a name for your email campaign.
4. In the *Description* field, enter a description such as the campaign’s goal or theme.
5. In the *Folder* field, select a folder to store the campaign. If you do not select a folder, the program saves the campaign in the root *Email Campaigns* folder.
6. To assign security rights for the campaign, select the Targeting and security tab. For each user role, you can manage rights to view, edit, delete, and change security. To add users or roles, click *Add users and roles*.
7. Click *Save*. You return to *Campaigns*. 

---

CHAP\_\_1

---
Create Efforts

You can create multiple email efforts and test the effectiveness of each message. The Email Effort Wizard is a series of tabs that guides you through creating one. On these tabs, you select the email lists and messages for the effort, send test and final email messages, and view the results. You can view message and target list summary reports to monitor the success of individual messages and target lists. You can also view the effort summary report to evaluate the success of all messages and lists associated with the effort.

The flowchart provides an overview of the effort creation process.

Create an effort

1. From Campaigns, find the email campaign to add the effort to. In the upper right pane, the campaign appears. In the bottom pane, any efforts previously created for the campaign appear.
   - To find a campaign from the Folders tab, select the folder that contains the campaign.
   - To find a campaign from the Search tab, search for the campaign by name.
2. Click **New email effort**. The New Email Effort screen appears.
3. In the **Name** field, enter a name for the email effort.
4. In the **Description** field, enter a description that identifies the effort.
5. Click **Next**. The Email Effort Wizard appears and opens to the 1: Target Lists tab. For information about this tab, see [Complete the 1: Target Lists tab on page 8](#).

**Complete the 1: Target Lists tab**

On the 1: Target Lists tab, you select email lists containing the primary recipients you are targeting for your effort. You select email lists saved in Lists; these can be query-based or imported. For more information about email lists, see [Lists on page 66](#).

1. From the 1: Target Lists tab, click **Insert target list**. The Select Lists screen appears.
2. To add an email list, select the list on the left and click **Add** to move it into the **Selected lists** box. Add each list as required.
3. Click **OK**. You return to the 1: Target Lists tab. In the grid, the selected lists appear.
4. In the **Action** column, view a summary report or the properties of the selected target list. You can also remove the selected target list from the effort.
   - To view a summary report for the selected target list, click **Click here to view report**. The tabs on this report display the same information as the Target List Results on the Results tab. For more information, see [Complete the 7: Results tab on page 12](#).
   - To view the selected target list’s properties, click **Click here to view/edit this target list’s properties**. On the List Properties tab, view the list’s data source and query or import file name. The **List status** box displays whether the program loaded the list successfully or if there are any errors. On the View List tab, view a list of all recipients included in the list. On the List Templates tab, view a list of all templates associated with the selected list. On the List Messages tab, view a list of all messages sent to the selected list.
   - To remove the selected target list from the effort, click **Click here to delete this target list**.
5. In the **Data source** column, view the data source for the lists, such as a query of constituents or an imported list.
6. If a problem exists with a selected list, the error appears in the **Loaded status** column. To resolve the error, exit **Campaigns** and open the email list in **Lists**, where you can edit the
queries that make up the list or replace the *.csv file that creates an imported list. If the list is imported, you can also change the field mapping for the email address and the recipient display name. For information about how to edit a list, see Lists on page 66.

**Note:** Each recipient in a target list receives one email from the effort. After you add a target list, you can run a duplicate search to identify any email addresses that appear in more than one target list. For more information about duplicate searches, see Search for duplicate email addresses on page 14.

7. To select the seed lists that contain the recipients to copy on all test messages, select the 2: Seed Lists tab. For information about this tab, see Complete the 2: Seed Lists tab on page 9

To save and return to Campaigns, click **Return**.

**Complete the 2: Seed Lists tab**

On the 2: Seed Lists tab, you select seed lists that contain the recipients to copy on all test messages. These are typically people in your organization who track the progress of the effort. On the Lists tab of the effort summary report, you can view the statistics for test messages sent to seed lists. Seed lists are excluded from statistics on all other tabs of the report, such as the Messages Sent and Click-throughs tab.

1. From an open effort, select the 2: Seed Lists tab.
2. Click **Insert seed list.** The Select Lists screen appears.
3. To add a seed list, select the list on the left and click **Add** to move it into the **Selected lists** box. Add each list as required.
4. Click **OK.** You return to the 2: Seed Lists tab. In the grid, the selected lists appear.
5. In the **Action** column, you can view a summary report or the properties of the selected seed list. You can also remove the selected seed list from the effort.
   - To view a summary report for the selected seed list, click **Click here to view report.**
   - To view the selected seed list's properties, click **Click here to view/edit this Seed List’s properties.** On the List Properties tab, view the list's data source and query or import file name. The **List status** box displays whether the program loaded the list successfully or if there are any errors. On the View List tab, view a list of all recipients included in the list. On the List Templates tab, view a list of all templates associated with the selected list. On the List Messages tab, view a list of all messages sent to the selected list.
   - To remove the selected seed list from the effort, click **Click here to delete this Seed List.**
6. In the **Data source** column, view the data source for the lists, such as a query of constituents or an imported list.
7. If a problem exists with a selected list, the error appears in the **Loaded status** column. To resolve the error, exit Campaigns and open the email list in Lists, where you can edit the queries that make up the list or replace the *.csv file that creates an imported list. If the list is imported, you can change the field mapping for the email address and the recipient display name. For information about how to edit a list, see Lists on page 66.
8. To select the exclusion lists that contain the recipients to exclude from all email sent for this effort, select the 3: Exclusion Lists tab. For information about this tab, see Complete the 3: Exclusion Lists tab on page 10.

To save and return to Campaigns, click **Return**.
Complete the 3: Exclusion Lists tab

On the 3: Exclusion Lists tab, you select exclusion lists that contain recipients to exclude from all email sent for the effort. Exclusion lists allow you to exclude recipients without editing the existing target list. For example, if you send a follow-up email to an effort, you can exclude recipients who donated as a result of the previous email.

1. From an open effort, select the 3: Exclusion Lists tab.
2. Click Insert exclusion list. The Select Lists screen appears.
3. To add an exclusion list, select the list and click Add. It appears under Selected lists. Repeat for each list to add.
4. Click OK. You return to the 3: Exclusion Lists tab. In the grid, the selected lists appear.
5. In the Action column, view the properties of the selected exclusion list. You can also remove the selected exclusion list from the effort.
   • To view the selected exclusion list’s properties, click Click here to view/edit this Exclusion List’s properties. On the List Properties tab, view the list’s data source and query or import file name. The List status box displays whether the program loaded the list successfully or if there are any errors. On the View List tab, view a list of all recipients included in the list. On the List Templates tab, view a list of all templates associated with the selected list. On the List Messages tab, view a list of all messages sent to the selected list.
   • To remove the selected exclusion list from the effort, click Click here to delete this Exclusion List.
6. In the Data source column, view the data source for the lists, such as a query of constituents or an imported list.
7. If a problem exists with a selected list, the error appears in the Loaded status column. To resolve the error, exit Campaigns and open the email list in Lists, where you can edit the queries that make up the list or replace the *.csv file that creates an imported list. If the list is imported, you can also change the field mapping for the email address and the recipient display name. For information about how to edit a list, see Lists on page 66.
8. To create test messages for each target list, select the 4: Messages tab. For information about this tab, see Complete the 4: Messages tab on page 10.
   To save and return to Campaigns, click Return.

Complete the 4: Messages tab

On the 4: Messages tab, you create test messages for each target list.

1. From an open effort, select the 4: Messages tab.
2. For all the target lists, create each message.
   a. Select a list in the Target List pane and click New message. The Select Template screen appears.
   b. In the Template field, select an email template for the message. The templates that appear in the list are those associated with the target lists type. For example, if the target list is
based on a query of constituents, templates with “Constituents” or “Generic” selected in the 
**Data source** field appear.

c. Click **Next**. The Email Properties screen appears.

d. In the **Name** field, enter a unique name to help identify the email.

e. In the **Issue date** field, the current date and time appear automatically. To edit the issue 
date, enter a different date and time.

f. The bottom pane displays the email’s default content. You can use the HTML editor to 
change the message’s content, appearance, and layout.

**Warning:** Blackbaud recommends that you use inline styles, such as `<div style="background-
color:Blue;">Welcome color</div>`, when you create and design the email content. Do not define 
classes or use external references because email vendors, such as Gmail or Outlook, are not 
guaranteed to render the styles correctly when the recipient reads the email.

g. To save the message, click **Save**. You return to the 4: Messages tab.

3. To set test parameters for each message, select the 5: Send Tests tab. For information about 
this tab, see **Complete the 5: Send Tests tab on page 11**.

   To save and return to **Campaigns**, click **Return**.

**Complete the 5: Send Tests tab**

On the 5: Send Tests tab, you set test parameters for each message. You can test variables for each 
message, such as the message’s content, subject line, scheduled time of departure, and the name 
and email address used for sending. You can also define the sample size for each test message.

1. From an open effort, select the 5: Send Tests tab.

2. To create test parameters for a message, select a list in the Target List pane and select a 
message in the Messages for `<Target List>` pane.

3. For each message, set the test parameters.

   a. In the Test Message Parameters pane at the bottom, the **Subject**, **Send date**, and **From** fields 
display the default values from the message’s email template. You can enter new values for these fields.

   b. In the **Sample size** field, specify how many recipients included in the target list are to receive 
the test message.

      To send the test message to a percentage of the recipients, select “Percent of list” and enter the 
      percentage of recipients.

      To send the test message to a specific number of the recipients, select “Recipients” and enter the number of recipients.

**Note:** To send the test message to the entire target list, select “Percent of list” and enter “100%,” 
or select “Recipients” and enter the total number of eligible records in the target list.

   c. Specify whether to send the test message now or later.

      To send the test message now, click **Send test message**. The test parameters are disabled, 
and the Status displays “Processing” as the email messages processes. After the email is 
processed, click **Refresh**. The Status displays “Sent.”
To save the test parameters and send the test message at a later time, click **Save.** When you later open the effort, you can then click **Send test message** to send the message.

4. To send the message that has the best test results to all remaining recipients for each target list, select the 6: Send Final tab. For information about this tab, see **Complete the 6: Send Final tab on page 12.**

To save and return to **Campaigns,** click **Return.**

**Complete the 6: Send Final tab**

On the 6: Send Final tab, you can send the message with the best test results to all the remaining recipients, such as those who did not yet receive an email, in a target list. This message is not sent to any seed list recipients.

1. From an open effort, select the 6: Send Final tab.
2. Select a target list. In the Results of Test Messages pane on the right, all the test messages for that list appear.
3. To identify the most successful test message, select each message and view its results.
4. Select the message to send as the final message to all remaining recipients in that target list and click **Send as final.** A confirmation message appears.
5. Click **OK.** The Final Status displays “Processing” as the final email messages are sent.
6. After the email is processed, click **Refresh.** The Final Status displays “Sent.”
7. To view the results for each target list, select the 7: Results tab. For information about this tab, see **Complete the 7: Results tab on page 12.**

To save and return to the Campaigns, click **Return.**

**Complete the 7: Results tab**

On the 7: Results tab, you can view the results for each target list.

1. From an open effort, select the 7: Results tab.
2. In the **Target lists** box on the left, select a list. In the box on the right, information about the target list appears. To view information about the list’s results, select the applicable tab.
   - To view a pie chart of the percentage of messages that are sent and not sent to the selected list, select the Summary tab. A table displays the number of sent and not sent messages to the list and the total number of recipients.
   - To view a pie chart of the opened, unopened, and undelivered messages sent to the selected list, select the Sent tab. A table breaks down the number of opened, unopened, and undelivered messages by the total number sent email to the list, the percentage of sent email, and the percentage of total messages.

The **% of Sent** column displays the percentage of opened and unopened email, excluding those that are undelivered. The **% of Total** column includes all email, including the undelivered.

- To view the pages the recipients in the target list access from links in the message, select the Click-throughs tab.
• To view the transactions generated by the recipients in the target list as a result of the email message, select the Conversions tab.

• To view summary information about each message sent to the target list, select the Message tab. To view a summary report about a specific message, click the message’s name in the Test message column. For more information about the message summary report, see View a message summary report on page 13.

3. Click Save.
4. To return to Campaigns, click Return.

View a message summary report
The message summary report contains information about a specific email message.

1. From an open effort, select the 7: Results tab.
   • To view the delivery status of the message, select the Delivery summary tab. A pie chart displays the percentage of messages sent and not sent and a table displays the total number of messages sent and not sent.
   • To view a pie chart of the opened, unopened, and undelivered messages, select the Messages sent tab. A table breaks down the number of opened, unopened, and undelivered messages by the total number sent email, the percentage of sent email, and the percentage of total messages.

The % of Sent column displays the percentage of opened and unopened email, excluding those that are undelivered. The % of Total column includes all email, including the undelivered.

   • To view the pages the recipients access from links in the message, select the Click-throughs tab.
   • To view the transactions generated by the recipients as a result of the message, select the Conversions tab.
   • To view a breakdown of message results for each target list, select the List details tab. To view a summary report about a specific target list, click the list’s name.
   • If the message included conditional content, the Conditional Content tab appears. The grid lists statistics about how each condition in a content block performed. It includes the number of recipients that received the condition, the number who opened the email, the number of click-throughs, the number of conversions (transactions), and the total gift amounts. For more information about conditional content, see Add Conditional Content on page 23.

Note: To view an Email Status Report, click Status report on the Summary tab. The Email Status report contains the time and date the program created, prepared, processed, uploaded, and accepted the message.

2. To view all the recipients of the message, select the Recipients tab. The grid displays each recipient’s name and email address and the date and time the message was sent. If the message bounced or was opened, the date and time are also included.
3. To view details about the email and preview the message’s content, select the Properties tab.
4. To close the report, click OK. You return to the 7: Results tab.
5. To return to Campaigns, click Return.
View an effort summary report

The effort summary report provides a current snapshot of the effort’s results. This report includes information about all messages sent to lists as part of the effort.

1. From Campaigns, under Email efforts, select the effort.

2. In the Action column, click Click here to review report. The Email Effort Summary Report screen appears. On this screen, you can select tabs to view information about the email results.
   
   • To view the recipient summary of all messages sent for the effort, select the Delivery summary tab. A pie chart displays the percentage of messages sent and not sent, and a table displays the total number of messages sent and not sent.
   
   • To view a pie chart of the opened, unopened, and undelivered messages, select the Messages sent tab. A table breaks down the number of opened, unopened, and undelivered messages by the total number of sent email, the percentage of sent email, and the percentage of total messages.

   The % of Sent column displays the percentage of opened and unopened email, excluding those that are undelivered. The % of Total column includes all email, including the undelivered.

   • To view a pie chart showing the percentage of messages that were not sent for the effort because of opt-outs, no addresses, and invalid accounts, select the Messages not sent tab. A table breaks down the number of opt-outs, no addresses, and invalid accounts by the total number of messages not sent, the percentage of messages not sent, and the percentage of total messages.

   The % of Not Sent column displays the percentage of messages not sent. The % of Total column includes all email sent and not sent, including those delivered successfully.

   • To view the pages the recipients access from links in messages sent for the effort, select the Click-throughs tab.
   
   • To view the transactions generated by the recipients as a result of messages sent for the effort, select the Conversions tab.
   
   • To view a breakdown of message results for each target list, select the List details tab. To view a summary report about a specific target list, click the list’s name. The tabs on this report display the same information as the Target Lists Summary Report on the Results tab.

3. To close the report, click OK. You return to the Wizard screen.

Search for duplicate email addresses

You can search for email addresses that appear in more than one target list.

1. Access the Search for Duplicates screen.
   
   • From Campaigns, click the Duplicate search button for the effort to search for duplicates.
   
   • From the Email Effort Wizard screen for the effort, click Duplicate search to search for duplicates.

2. Select the Duplicate Search tab.

3. To run the duplicate search, click Start. The Search Status displays “This effort has been queued for searching.” The amount of time the search is queued can be longer than 30 minutes. These items determine how long a search is queued:
• The intervals set under **List acquisition and refresh** on the Settings tab in *Sites & settings*. If you start a duplicate search while a list is being refreshed, there may be a delay because the search cannot begin until the list refresh is complete. For more information, see the *Administration Guide*.

• The number of lists queued for refresh before the search. Those lists must refresh before the duplicate search can begin.

4. When the search is queued, close the Duplicate Search screen.

5. After the search is complete, open the Duplicate Search screen again. The Search Status displays “This effort has been successfully searched” and a grid displays any email lists that contain duplicate email addresses.

6. To view email addresses that appear in multiple target lists, select the Duplicate Records tab.

7. The grid displays the email addresses that appear in multiple target lists. Using the filter options at the top of the grid, you can filter the list of duplicates by email address, recipient name, or target list.

**Note:** Search results on the Duplicate Records tab are not dynamic. The records that appear in the grid are those from the last search. Any changes made to target lists since the last search, such as due to reacquiring, adding, and removing, do not appear. To update the search results, click **Start** to run the search again.

8. To close the Duplicate Records screen, click **Close**.

**Templates**

**Warning:** It is important that your organization assigns full Administrator rights to only a select number of users for *Templates*. Any changes can affect multiple web pages. We strongly encourage users knowledgeable in all areas of website design to perform tasks in *Templates*.

In *Templates*, you design and maintain email templates to provide consistency for various types of email. For example, you can have an organization template with a header and font used to send email to all alumni. On the Properties tab, you set defaults for the messages created from the template, such as the from name and subject. On the Design tab, you design the basic layout for the template, including any graphics or pictures.

**Show Me:** Watch [how to create an email template](#).

When you create an email message, you base the message on a template to save time and effort. All the elements exist in the template. You can change a specific message, but the template provides a base that helps maintain consistency.

**Note:** In each email you send, you must include links to the pages on your website that contain your organization’s privacy statement and the User Email Preferences Form so recipients can opt out of your email communications. We recommend you include these links in email templates.
Mobile Friendly Email Templates

To improve your email marketing for mobile users, six mobile friendly email templates are available for you to copy and use as new templates. These templates are more narrow in width and include larger fonts for improved usability for a specific mobile device, such as a smartphone or tablet.

You can easily identify these in the email templates grid by viewing templates with “Placeholder” in the Description column. One copy of each mobile friendly email template exists in the program. When you host multiple websites, you access them in each site’s Templates area.

To use these templates, create a copy of one and update the placeholder text in the new template with your unique content. For example, you can replace the merge field placeholder text with merge fields in the HTML editor. You can also replace the sample logo banner with your organization’s logo banner.

Tip: These templates are mobile friendly but not responsive; they do not render differently across diverse devices. To learn about designing a responsive email template for multiple devices, such as smartphones, tablets, browsers, desktop, and web-based email programs, visit Responsive Page Design in the Developer Guide.

Design an email template

You do not send email messages or select email recipients from Templates. You send email messages from Messages and save email recipients as email lists in Lists. For more information about how to send email messages, see Messages on page 32. For more information about email lists, see Lists on page 66.

Show Me: Watch how to create an email template.

1. From Email, click Templates. Templates appears.
2. Click New template. The New template page appears.
3. On the Properties tab, enter a name for the email template in the **Template name** field. Keep in mind that you use the template for all email messages of this type.

4. In the **Description** field, enter additional information about the template such as a brief description or notes about the template.

5. In the **Data Source** field, select the data source. The Data source determines which type of list can be used for messages created from the template and which merge fields are available when you write email content. When you set a data source on a template, messages created from the template can be sent to only lists that use the same type of data source. For more information about the types of data sources, see Template Data Sources on page 20.

6. If you select “Constituents” or “Chapter,” the **Export definition** field appears. In this field, click the binoculars to select an export definition from Blackbaud CRM. The fields you include in the **Selected Fields** box on the export definition screen in Blackbaud CRM appear as merge fields in the email design pane. This provides a way for you to include any applicable field in Blackbaud CRM as a merge field in Blackbaud Internet Solutions.

**Note:** You can only select export definitions with a record type of Constituent in the **Export definition** field. To verify the record type, go to Administration, Export definitions in Blackbaud CRM. The program automatically includes the CMS Constituent Email Export Definition by default. For information about export definitions, see the Blackbaud CRM Query and Export Guide.

   If you select “Constituents,” the **Email address type** field also appears and defaults to use the constituent’s primary email address. To use a different email type when messages are sent using this template, select it from the list. When a constituent does not have the email address type you select in the field, the message is sent to their primary email address.

**Note:** To change the email address type a message inherits from its template, select it from the
Email address type field when you create the message. For more information, see Design and send an email message on page 32.

7. In the Appeal field, select the appeal you want to associate with the template. You can add or change the appeal when you create email messages that use this template.

8. In the Subject, From Name, and From Address fields, enter a default subject to include in the Subject field of email messages you create with the template, as well as an email address and name to include in the From field of email messages. When you create email messages, you can overwrite the subject.

Note: Because you do not send email from Templates, the program does not include recipients in the Send to field in the email template. The program saves the recipients as an email list in Lists. For information about email lists, see Lists on page 66.

9. To receive responses from recipients at a different email address than the one you use to send the message, enter a return address in the Reply Address field.

10. To receive failure messages when email messages are not delivered, select Failure to send notification. In the Notification email address field, enter an email address to receive failure messages.

Note: Failures are email addresses that do not receive the messages. Failure can also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status Notifications (DSN). For information about how the program handles failures, see Bounced Email Management on page 43.

11. To assign security rights for the email template, select the Targeting & Security tab. For each user role, you can manage rights to view, edit, delete, and change security.

12. To add users or roles, click Add users and roles.

13. To assign rights, select View, Edit, Delete, or Change Security.

Note: Edit rights allow users to edit the template and its defaults. To use the template to create email messages, users only need View rights. If users edit a template, the changes do not affect email messages previously created based on the template.

For more information about security and user roles, see the Users & Security Guide.

14. Click Save. The template opens to the Design tab.
Note: To see the scroll bar on an email template, you must use a screen resolution of greater than 800 x 600.

15. Enter the default content for all email messages created from this template.
   To have personalized information from other Blackbaud programs appear in messages created from this template, add merge fields.
   a. To display the list of available merge fields, click Merge fields on the Insert tab in the toolbar. To expand the list, click the plus sign next to a field category.
      If the template uses a "Constituents" or "Chapter" data source, the merge fields that appear are based on the export definition you select in the Export definition field on the Properties tab.
   b. To add a merge field to the message, double-click or drag and drop a field in the content area.
   c. Put fields where you want them to appear in the body of the email. For example, enter “Hello, First Name.” In the email, “Hello, [recipient's first name]” appears. To move a field, click and drag it to the new location.
      For example, you can create an email template for messages sent to existing program users who attempt to register again. In the bottom pane, you can enter the content required to remind the user he is already a registered user and to provide the existing username and password information.

16. To add conditional content to the message to customize it for different types of recipients, click Conditional content on the Insert tab in the toolbar. For more information about conditional content, see Add Conditional Content on page 23.

17. Create links to the pages of your website that contain the User Email Preferences Form and your organization's privacy statement. You must include these links in each email you send.

18. To format the email template’s appearance and layout, use the HTML editor. For information about the HTML editor, see the Program Basics Guide.
Warning: Blackbaud recommends that you use inline styles, such as <div style="background-color:Blue;">Welcome color</div>, when you create and design the email content. Do not define classes or use external references because email vendors, such as Gmail or Outlook, are not guaranteed to render the styles correctly when the recipient reads the email.

19. Click **Save**.

**Warning:** If you select the Messages tab before you click **Save**, you lose the information you entered on the Design tab.

20. To send a message based on the new template, select the Messages tab and click **New message**. The New Message screen appears. For more information about how to send a message, see Design and send an email message on page 32.

21. To save the email template, click **Save**.
22. To return to Templates, click **Return**.

## Template Data Sources

You can select a data source for each template you create. The data source determines which type of list can be used for messages created from the template and which merge fields are available when you write email content. When you set a data source on a template, messages created from the template can be sent to only lists that use the same type of data source.

There are several types of data sources available to serve different purposes:

Constituents: Use the Constituents data source to send emails to lists based on queries of constituents from Blackbaud Internet Solutions. The Constituents data source provides the largest variety of merge fields for personalized messages. This is the option you will use most often.

Registered Users: Select the Blackbaud Internet Solutions data source for emails sent to users who have forgotten their login credentials and are attempting to register again or for emails sent automatically to imported users with their usernames and passwords.

Imported lists: If you import email lists from CSV files, those lists appear as data sources in this field. Select an imported list when you want to use a particular list for all messages created from a template.

Appeal: Select the Appeal data source for messages sent to constituents and anonymous users who subscribe to email communications, such as newsletters. Subscribers receive the message once their subscription is fully processed.

Chapter: Select the Chapter data source for messages sent to members of a chapter.

None: When you select None for the data source, you can send the message to any type of list, but the message will not include any merge field options for you to personalize messages.

**Note:** For more information about data sources for email lists, see Lists on page 66.

**View the tabs of an email template**

After you create an email template, you can view its properties, design, and any messages created based on it. If you have applicable security rights, you can also edit the properties and design of
the template. Changes made to the template do not affect individual email messages already created based on the template.

1. From Email, click Templates. Templates appears.

2. To search for a template, enter its name or subject, or select its data source in the filter fields and click Filter. The templates that match your criteria appear.

**Note:** The grid can display up to 50 results at a time. If you have more than 50 results, click Prev or Next to page through the results, or select the page number to view.

3. Next to the template to view, click Click here to edit this email template. The email template Properties screen appears.

4. On the Properties tab, view the properties and security settings entered when the template was created. To help you navigate through the information, the Properties tab contains the Properties and Targeting & Security tabs.

   • On the Properties tab, view the name, description, data source, and default mailing options entered when the template was created. If the template message contains merge fields, you cannot change the selected data source.

   When you host multiple sites, the Assign to site field appears on the Properties tab so you can move a template from its current site to another site. If the template is in use on the source site, it continues to be on that site. However, the template is now associated with the target site and its security.

   • On the Targeting & Security tab, view the security rights assigned to user roles for the email template.
5. To view the default content for all email messages based on the template, select the Design tab.

![Design tab](image1)

6. To view the messages created based on the template, select the Messages tab.

![Messages tab](image2)

7. To return to Templates, click Return.

**View a message created from an email template**

1. From Email, click Messages. Messages appears.
2. In the Filter by Template field select a template.
3. Click Filter. Messages that use the template appear.
   - To view a sent message, select it and click Click here to view report. The Message Report screen appears. For information about the tabs on this screen, see View the tabs of a sent message on page 1.
   - To view a message the program has not yet sent, select it and click Click here to edit this email message. The Email Editor page appears. For information about how to edit the message, see Design and send an email message on page 32.
Note: The grid can display up to 50 results at a time. If you have more than 50 results, click Prev or Next to page through the results, or select the page number to view.

4. To return to Messages, click Return.

Copy an email template

Save yourself time and effort. When you need to create a new email template and a similar one exists, copy and tweak the existing template to create the new one rather than start with a blank template.

1. From Email, click Templates. Templates appears.

2. To search for a template, enter its name or subject, or select its data source in the filter fields and click Filter. The templates that match your criteria appear.

Note: The grid displays up to 50 results at a time. If you have more than 50 results, click Prev or Next to page through the results.

3. Select a template and click Click here to copy this email template. The New template page appears with settings from the existing template.

Note: To improve your email marketing for mobile users, six mobile friendly email templates are available for you to copy and use as new templates. You can easily identify these in the email templates grid by viewing templates with “Placeholder” in the Description column. When you create a copy of one, make sure you update the placeholder text in the new template with your unique content. For example, you can replace the merge field placeholder text with merge fields in the HTML editor. You can also replace the sample logo banner with your organization’s logo banner. To secure the content in these templates, you cannot edit or delete them.

4. On the Properties tab, enter a new name in the Template Name field.

5. Edit the template settings as necessary. For information about how to design an email template, see Design and send an email message on page 32.

6. Click Save. The template opens to the Design tab with a layout based on the original template.

7. Edit the layout as necessary. For information about how to design an email template, see Design and send an email message on page 32.

8. Click Save.

9. To return to Templates, click Return.

Add Conditional Content

Add conditional content to an email message to customize the message for different types of recipients. For example, you may send a message to alumni and the parents of current students where most content is the same but you need to customize some sections for the two groups of recipients. With conditional content blocks, you can create a single message that generates the two versions of the content. A conditional content block works as a container that holds different pieces of content and determines where the content appears in the message. Within the content block, you add “conditions,” which are chunks of content associated with a query or email list of recipients.
The example below demonstrates how this works. This message includes a conditional content block containing two conditions — a paragraph specifically for parents and another for alumni. When you send the message, recipients in the query or list of parents view the Parents paragraph and recipients in the query or list of alumni view the Alumni paragraph.

Dear [Name],

This is an exciting and historic year to be associated with Baxter College. As we celebrate our 100th anniversary, the campus has undergone some major physical improvements, and we are in the final months of the Centennial campaign for endowment and scholarship. As part of these improvements, we have constructed a new residence hall, renovated the library, and added a new wing to the Social Sciences building.

It was important to make these physical improvements during this pivotal time in the college’s history because Baxter needs to look ahead and prepare to meet challenges as it begins its second century. To support ongoing improvements, our challenge is to ensure a healthy endowment and strong scholarship program. Our Centennial campaign has a goal of $50 million in gifts and pledges by May 31, 2019. **This goal is within reach but we need your help!**

Parent support is a critical part of the Centennial campaign and there is a wonderful tradition of parent support at Baxter. Gifts from current parents will ensure that current students will have all the advantages they need in order to become the leaders of tomorrow. In fact, last year 50% of parents of alumni remained involved with Baxter with an annual gift. This is a fantastic participation rate and I hope that we will be able to increase it further with your help.

As a former student at Baxter, you understand how important it is to ensure that current and future students will have all the advantages they need in order to become the leaders of tomorrow. Every year our alumni help us raise money to meet the needs our college is facing. These needs include resources for upgrading technology, funds to attract the best faculty, and to help deserving students come to Baxter. Please join other alumni and friends who have decided to support Baxter’s students and programs with a gift to the Centennial campaign.

So in honor of this unique and historic time in the college’s history please consider making a gift to the Baxter College Fund today. Thank you!

Sincerely,

[Alumni Chair]
The Baxter College Fund

### Conditional content workflow

- **Determine your targets** — Create lists or queries that include the recipients to customize content for.
- **Add a condition block** — In the area where you want the content to appear, click **Conditional content** on the Insert tab in the toolbar.
- **Add condition** — Add the default condition. To add other conditions, define the content and select the group of recipients who can view it.

**Note:** The order of conditions is important because recipients may fall into more than one query or list. In that case, the recipient receives the most top-level condition. For example, you have a condition for each of these groups — Alumni, Parents, and Current Students. Because a parent could also be an alumnus, you need to order the conditions so the Parents condition appears at the highest level. This ensures that parents who are alumni receive the message intended for parents.

- **Verify content** — Use **Conditional content preview** on the View tab in the toolbar to verify that content appears as expected for each group of recipients.
• **Report on message results** — After the message is sent, view the Message Report to evaluate how each condition performed.

> **Add conditional content**

1. From an open message, click **Conditional content** on the Insert tab in the toolbar. The Conditional Content screen appears.

2. Enter a name for the conditional content block and click **OK**. You return to the message and the new conditional content block appears in the message.

3. The conditional content block includes a default condition automatically. The default content appears for any recipients not included in a condition specified for the block. You can leave the default condition blank or click **Edit** to access the Enter the default content screen.
4. Use the HTML editor to add text, merge fields, and images for the default content.

**Warning:** Blackbaud recommends that you use inline styles, such as `<div style="background-color:Blue;">Welcome color</div>`, when you create and design the email content. Do not define classes or use external references because email vendors, such as *Gmail* or *Outlook*, are not guaranteed to render the styles correctly when the recipient reads the email.

5. Click **OK** and you return to the message. If you added content to the default, it is now labeled with a brief preview of the text included in the condition.

6. To add the first condition, click **Add condition**. The Conditional Content screen appears.
7. To define the condition based on a query, select **Query** and click **Change**. The Query Search screen appears so you can select a query. To define the condition based on an email list, select **List** and click **Change**. The Select Lists screen appears so you can select a list.

8. Enter the content for this condition.
9. Click **OK**. You return to the message and the new condition appears in the conditional content box. The condition is labeled with the selected query or list and contains a brief preview of the text entered.
10. Continue to add conditions to the block as needed.
11. To edit a condition, click Edit.
12. To move a condition, click the up or down arrow.
13. To delete a condition, click Remove.
14. To preview each version of the message, click **Conditional content preview** on the View tab in the toolbar. The View Message screen appears. For more information about how to preview content, see [Preview Conditional Content on page 29](#). Click Close to return to the message.
15. Click Save. If you have created a message or newsletter, you can send the message to recipients.

After you send the message, the Conditional Content tab in the Message Report displays statistics about how each condition in the message performed. The report includes the number of recipients that received the condition, the number who opened the email, the number of click-throughs, the number of conversions (transactions), and the total gift amounts.

**Note:** Test messages do not display merge field data or conditional content as they will appear in the final message. Instead, the test message includes placeholders where these items will appear in the final message. To test merge fields and conditional content, select the test list in the To field and then select Send final.

### Preview Conditional Content

After you create a message that contains conditional content, you can preview each version of the message to verify that content appears as expected for each group of recipients. You can also view the approximate number of recipients who will receive each condition.

**Note:** You must add conditional content and select a target list before you can preview conditions or generate statistics.

#### Preview conditional content

1. From a message containing conditional content, click **Conditional content preview** on the View tab in the toolbar. The View Message screen appears.
2. Select the conditions in each block to view and click Preview. The message appears on the right.
3. To view the number of recipients who will receive each condition, click **Generate statistics**. The **Recipients** column displays the approximate number of recipients for each condition.
<table>
<thead>
<tr>
<th>Message</th>
<th>Recipients (Approx.)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Block 1</strong></td>
<td></td>
</tr>
<tr>
<td>Parents</td>
<td>2500</td>
</tr>
<tr>
<td>Students</td>
<td>4000</td>
</tr>
<tr>
<td>Default</td>
<td>1000</td>
</tr>
</tbody>
</table>
Note: Generate statistics does not appear on the View Message screen for email templates or email messages without a selected target list.

4. Click Close to close the View Message screen and return to the message.

Messages

In Messages, you can add, delete, and view email messages. To ensure consistency and save time, you can create an email message from an existing email template. You create email templates in Templates. We recommend only users with Administrator rights create and edit email templates.

Tip: When you delete an email message, it removes from the grid on the Messages page, but it remains in the database. To run a process that improves performance by permanently deleting these messages, schedule the Delete email permanently setting in Administration. For more information, refer to Delete email permanently on page 1.

You can also use an existing email message to create one. To do this, open and copy the existing email. You can change the copy as required, save it as a new email, and send the message.

Note: On the Messages screen, if Click here to edit this email message appears in the Action column, the program has not sent the email. Before you send an email, you can edit it in Messages. To make changes, click Click here to edit this email message.

Design and send an email message

When you create and design an email in Messages, it is sent only once. You can edit the email before you send it, but not after.

1. From Email, click Messages. Messages appears.
2. Click New message. The Select Template screen appears.
3. In the **Template** field, select a template. To decide on a template, consider the type of email you will write. For information about email templates, see [Templates on page 15](#).

4. In the **Site to select template from** field, select a site to narrow the list of templates you can use for the message. You can select a template from another site even though the message is for the site you are currently on. If you do not host multiple websites, your single site defaults in the field.

5. Click **OK**. The New message page appears.

   **Note:** To see the scroll bar on an email message, use a screen resolution greater than 800 x 600.

6. In the **Recipient lists** field, select the lists of recipients to include on the message.
   
a. If the message uses a template with a data source other than “Appeal,” click the binoculars. The Select Target Lists screen appears. The grid displays the saved email lists that you have security rights for and that match the data source type selected on the template.

   **Tip:** For more information about data sources, see [Template Data Sources on page 20](#).
You create and store email lists in *Lists*. Lists include individuals from offline constituent queries and imported lists. When the message uses a list with "Constituents" as the data source, individuals must have an email address that matches the type selected in the *Email address type* field on the template or message. Otherwise, the message is sent automatically to the primary email address on the individual's constituent record. When an individual's record is marked *Requests no email*, the individual is excluded from the list and does not receive the email message. For more information about *Lists*, see *[Lists on page 66]*.

**Note:** If the message uses a template with "Appeal" as the data source, the *Recipients* field automatically populates with the appropriate subscribers list. This list is based on the people who subscribed to the appeal category on an Email Signup form, which can include both registered and anonymous website users. To include additional recipients, click **Add additional recipient lists**. For information about the Email Signup Form, see the *Forms Guide*.

b. Enter criteria to narrow the list and click **Filter**. The grid displays the lists that meet the criteria.

**Note:** When the template's data source is “Chapter,” you can filter chapters by the Chapter Manager part name. In the *Filter by Name* field, enter the name of the Chapter Manager part. The grid displays the available chapters in a “Chapter Manager part name — Chapter name List” format. For example, “Alumni Chapter Manager — San Diego List” contains the members of the “San Diego” chapter created by the Chapter Manager part named “Alumni Chapter Manager.” To send the message to the members of a chapter, add it to the **Selected Lists** box.

c. To add a list, select it and click **Add**. The list appears in the **Selected Lists** box. You can
include multiple email lists.

Depending on your website environment and configuration, sending to a large list of recipients may cause performance issues. If you experience this, we recommend you include smaller queries or fewer queries in the list. For more information, see Create an email list on page 67.

d. To remove a list from the Selected Lists box, select it and click Remove.
e. Click OK. You return to the New message page.

7. To send the message to a test group, such as people in your organization that need to approve the message, in the Test lists and Test emails fields, specify recipients for a test version of the message.
   - In the Test lists field, click the binoculars to select the lists of recipients for the test version. The Select Test Lists screen that appears has the same options as the Select Target Lists screen.
   - In the Test emails field, enter email addresses if you do not use email lists or if you want to include recipients who are not in your lists.

   **Note:** We recommend that you send the email message to test recipients before the final recipients. The test recipients can review the message and verify its design in multiple email client readers. You can create lists of test recipients in Lists. For information about lists, see Test Lists on page 74.

8. In the email identifier fields, enter a name for the email message, a subject to include in its Subject field, and an email address and name to include in the From field.

   **Note:** If the template includes a subject, it automatically appears in the Subject field. You can edit the subject as necessary.

9. In the Issue date field, enter when you created the email message. By default, the current date and time appear.

10. In the Send after date field, enter when to send the email message. By default, the current date and time appear. However, you can schedule the email for a future date or time. For example, you may be out of the office for the next month but need to send your regular weekly email during that time. Or you may design an event marketing campaign and schedule email messages to send as reminders one week, three days, and the day before the event.

   - To send the email at a future date or time, enter the date and time. The website does not process the email until the date and time you enter when you click Send final.

     If you delete the email before the date you enter in the Send after date field, the program does not process the email and it is not sent to recipients.

   - To immediately send the email when you click Send final, leave the current date and time.

11. The Appeal field defaults to the appeal selected for the template the message uses. When this field is blank or if you want to change the appeal, click Change. The Appeal Search screen appears. For information about how to use the search screen, see the Program Basics Guide.

12. The Email address type field defaults to the type selected for the template the message uses. When this field is blank or if you want to change the type, select it from the list.

13. To receive responses from recipients at a different email address than the one you use to send
the message, click **More Options** and enter the address in the **Reply Address** field.

14. Under **Notifications are to be sent to the following addresses**, select **Failures** to receive failure messages when email messages are not delivered. In the field beside the checkbox, enter an email address to receive failure messages.

**Note:** Failures are email addresses that do not receive messages. Failure can also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status Notifications (DSN). For information about how the program handles failures, see [Bounced Email Management on page 43](#).

15. The bottom pane displays the email's default content. To format the message's appearance and layout, use the HTML editor.

For information about the HTML editor, refer to the *Program Basics Guide*.

**Warning:** Blackbaud recommends that you use inline styles, such as `<div style="background-color:Blue;">Welcome color</div>`, when you create and design the email content. Do not define classes or use external references because email vendors, such as *Gmail* or *Outlook*, are not guaranteed to render the styles correctly when the recipient reads the email.

When you design an email message, you must include hyperlinks to the Privacy Page specified on the Settings tab in *Sites & settings* and a User Email Preferences Form on your website. For more information, see the *Administration Guide*.

To personalize the message with information about the constituent, add merge fields.

a. To display the list of available merge fields, click **Merge fields** on the Insert tab in the toolbar.

If the message is based on a template with a "Constituents" or "Chapter" data source, the merge fields that appear are based on the export definition selected for the template. For more information about templates and export definitions, see [Design an email template on page 16](#).

b. To add a merge field to the message, double-click or drag and drop the field in the content area.

c. In the body of the email, put fields where you want them to appear. For example, enter "Hello, First Name." In the email, the recipient reads “Hello, [the recipient's first name].” To move a field, click and drag it to the new location.

**Note:** When you add a link in your message to a Blackbaud Internet Solutions web page, the URL contains valuable information to track data and to automatically populate biographical information on your web page. Use this example to identify each piece of data the URL includes: http://www.yourdomain.org/DonationForm&srcid=[source ID]&srctid=[source type ID]&erid=[email recipient ID]&trid=[tracking ID].

d. To add conditional content to the message to customize it for different types of recipients, click **Conditional content** on the Insert tab in the toolbar. For more information about conditional content, see [Add Conditional Content on page 23](#).

16. Click **Save**.
Send the message

- To send the message to the test recipients, click Send test. The message may take a few minutes to send if you use a large list. When the program sends the email message, you return to Messages.

When you receive the test email, verify the message and its components look and work correctly before you send the final email.

**Note:** Test messages do not display merge field data. Instead, the program includes placeholders where the merge data will appear in the final message. Also, the program disregards the value in the Send after date field when you click Send test and immediately sends the test message.

- To send the message to its final recipients now or at the scheduled date and time, click Send final. The Send Status tab appears for you to view the target lists, the number of recipients in each list, and when the lists were last refreshed.

To make sure the latest recipients are in the queries that the lists use, click Refresh Lists. An informational message then appears for your review before clicking Start Refresh to begin the process. After it completes, click Yes on the tab to actually send the final email to recipients.

**Note:** You are not required to refresh the lists before sending the message.

When you send the final email, one more refresh occurs automatically for lists that use dynamic queries. This may cause the recipient numbers on the Sent Status tab to differ from the final sent numbers that appear in email reports. If your lists use static queries, this does not apply. For more information about email statuses, refer Email Delivery Status on page 44.

- To send the message to the test or final recipients at a later time, click Return. You return to Messages. The new email appears at the top of the list. To send the email, click Click here to edit this email message. When the email message opens, click Send test or Send final.

**Note:** Each email is sent with a text version in addition to its HTML-formatted version. Email client readers that display text only either display this text version or generate a text version from the HTML. You cannot alter the text version of the email.

Copy an email message

Each sent email contains a text version in addition to its HTML-formatted version. Email client readers set to display text only show either this text version of the email or its own text version, generated from the HTML. You cannot alter the text version of the email.

1. From Email, click Messages. Messages appears.
2. Enter criteria to narrow the messages in the grid and click Filter. The messages that match your criteria appear.

**Note:** The grid displays up to 50 results at a time. If you have more than 50 results, click Prev or Next to page through the results.

3. Select a message and click Click here to copy this email message. The New message page appears.
Note: To copy a message, you can also open it and click Copy message.

4. In the Name field, enter a new name.

5. Edit the message as necessary. For information about how to design an email message, see Design and send an email message on page 32.

6. From Email, click Messages. Messages appears.

   - If the message includes an email list of test recipients, send the message to the test recipients. Click Send Test. Depending on the size of the selected test list, the message may take a few minutes to send. When the program sends the email message, you return to Messages.

     After the test recipients verify the email message and its components look and work correctly, send the email to its final recipients. From Messages, click Click here to edit this email message. When the email message opens, click Send Final.

   - To send the message to its final target recipients now, click Send Final. Depending on the size of the selected email list, the message may take a few minutes to send. When the program sends the email message, you return to Messages.

   - To send the message to the test or final recipients at a later time, click Return. You return to Messages. The new email appears at the top of the list. To send the email, click Click here to edit this email message. When the email message opens, click Send Test or Send Final.

View sent email statistics

Show Me: Watch how to view and learn about email statistics.

When you analyze the statistics for an email message, you evaluate how effective the email is and you can also use the information to help determine areas of improvement for your future email messages. After you send a message, you can view its status log and performance statistics from the Messages page.

View the performance statistics for an email message

1. From Email, click Messages. Messages appears.

2. Select a message and click Click here to view report ( ) in the Action column. The performance statistics grid displays below the message row.

Tip: If the button doesn't display, the email has not yet been sent and therefore there are no statistics to view.
Tip: Hover over each statistic title to view a description of how the value was calculated.

- **Open rate**: Displays the percentage of delivered emails opened by recipients. Messages are considered open when the recipient allows an image to display or clicks a link.
- **Click rate**: Displays both the click-through rate (CTR) and the click-to-open rate (CTOR). The CTR is the percentage of unique recipients who clicked links in the email over the number of delivered messages. The CTOR is the percentage of unique recipients who clicked links in the email over the number of opened messages.

To track click-throughs, the program associates email IDs with email messages. When you include a link in an email message, the program appends a destination link value that includes the email ID to the site URL that you specify in Sites & settings. When an email recipient clicks the link, the program redirects the user to the page through the site and then associates any resulting activity with the email ID.

If a user clicks multiple links in the email, both percentages only count one click per user.
- **Transaction rate**: Displays both the transaction rate and the transactions to click rate. The transaction rate is the percentage of unique recipients who completed transactions from the email over the number of delivered messages. The transactions to click rate is the percentage of unique recipients who completed transactions from the email over the number of opened messages.
- **Average gift**: Displays the average gift amount that users gave in response to the email for donation, event registration, and membership transactions.

4. In the bottom row of the grid, view the following email activity statistics and the total amount raised:
   - **Recipients**: Displays how many people received the message. Click the amount to display the list of recipients, including email addresses, names, and actions.
   - **Opens**: Displays how emails were opened. Click the amount to display the list of recipients who opened the email. The message is considered open when the recipient allows an image to display or clicks a link.
   - **Clicks**: Displays how many recipients clicked links in the message. Click the amount to display a list of recipients and which links they clicked.
• **Transactions:** Displays how many transactions (including donations, event registrations, and membership transactions) your organization received as a result of the message. Click the amount to display a list of recipients whose transactions were received.

**Note:** For the statistics above, when displaying the list of recipients, you can search the list by entering an email address, first name or last name in the **Search** field. You can click each email address to view performance statistics specific to that individual, including how many emails he received, his open rate, click rate, and conversion rate, and the total gift amount of his email transactions.

**Note:** When an email recipient forwards your message to other recipients, their statistics are also captured in the grid for all percentages and counts. For example, Mark Adamson receives your latest Annual Fund email and forwards it to Jane Smith. Jane opens the email and clicks the Annual Fund link to submit a donation on your website. The grid updates to include Jane’s data in all applicable statistics and her email address also appears in lists related to the counts in the bottom row.

• **Total raised:** Displays the total amount of money raised as a result of the message. This total includes donation, event registration, and membership transactions.

5. Next to the grid, you can view the following additional statistics:

a. Click the link beside **Lists** to display the distribution list names and view the number of recipients for each list. You can then click on each list name to view details about the messages that were not sent.
b. Beside Not Sent, Bounces and Opt-outs, click the amount to display more information associated with the statistic, such as email addresses, recipient names, and types.

**Not Sent**: Displays the number of emails that were not sent due to missing addresses or invalid accounts.

**Bounces**: Displays the number of bounced emails. For more information, see [Bounced Email Management on page 43](#).

**Opt-outs**: Displays the number of recipients who opted out of receiving email from your organization.

When someone informs you they did not receive a message, refer to these statistics first to determine why. Click the corresponding value for Not Sent, Bounces and Opt-outs, then review the email addresses and types to see if this clarifies why the email was not received. It may be possible that the email was overlooked in the recipient’s inbox.
To search the data, enter your criteria in the Email address, Name, or Type fields, then click Search.

To save the displayed data as a *.csv file, click .

If the email is query-based, you can make sure the recipient appears in your query results. If you used an import list for the recipients, make sure the individual appears in the import file.

**Note:** If delivery fails because the recipient’s Internet Service Provider (ISP) reports that the email address is invalid, the email address is automatically added to Invalid accounts. Typical causes of an invalid account occur when the email address contains a typographical error or the email account is canceled due to inactivity. Accounts that bounce email for another reason, such as a temporary network issue, a full mailbox, or a content filter, do not appear in Invalid accounts. For information about Invalid accounts, see Invalid Accounts on page 75. For information about how the program handles accounts that bounce email but are still valid, see Bounced Email Management on page 43.

6. Click Additional Information, then click the following tabs to view more statistics:

- **Click Map:** Displays the links included in the email. Hover over a text or image link to view the corresponding email statistics.
- **Click Report:** Displays a listing of total click-throughs by page, including the total number of views (the number of times the links were clicked) and the number of unique viewers (the number of recipients who clicked the links).
- **Conversions:** Displays the number of online transactions, such as donations and event registrations, generated as a direct result of the email message. For each conversion type, the total amount of money raised, the payment method, and the number of transactions for each method are shown.
- **Properties:** Displays the message content and properties.

7. You can export statistics to a *.csv file. To do this, under Additional Information, click Export. Next, select Summary or Details for the format. The summary version displays a brief summary of each statistic; the detailed version includes all recipients and actions.

8. To close the email statistics grid, click in the Action column for the email message.

**Warning:** When you delete an email message, its performance statistics are also removed.

**View the status report for an email message**

For additional information about the status of the email message, click Email Status Log in the Action column or to the right of the statistics grid next to Status. Depending on the status of the email job, the icon displays as one of the following:

- ✔ - Completed
- ✔️ - In progress
- ⚠️ - Failed

Click the icon to display the email status report which shows the status and time of your email job at different points in the process. Click Show details to view specific information about the email status. After you check the status, close the report.
Bounced Email Management

A “bounced” email is one that is sent but cannot be delivered. The email Message Report includes details about two types of bounces: hard and soft. A hard bounce occurs when you send the message to an invalid account. A soft bounce occurs if the message reaches the recipient’s mail server but cannot be delivered. This may happen, for example, if the recipient’s mailbox is full or the size of the message is too large. You can view a breakdown of how many messages bounced and the type of bounce that occurred.

- To view a breakdown of how many copies of a sent message bounced, click the Bounces link on the email statistics grid on the Messages page. For more information, see View sent email statistics on page 38.
- To view a breakdown of how many copies of a sent acknowledgement bounced, select the Acknowledgements Sent tab of the Acknowledgements Report tab on the Acknowledgements
Report screen. For information about the Acknowledgements Report tab, see View the tabs of a sent acknowledgement email on page 57.

If a sent email bounces, you can view the bounce error. For a message or newsletter, you can view bounce information on the Recipients tab on the Message Report or Issue Report screen. For an acknowledgement, you can view bounce information on the Messages tab on the Acknowledgement Report screen. To view a bounce error of an email, click Click here to view detailed bounce information in the Actions column. The Bounce Information screen appears and displays the exact wording of the bounce error. For information about the Recipients tabs, see View sent email statistics on page 38 or View the tabs of a sent newsletter issue on page 51. For information about the Messages tab, see View the tabs of a sent acknowledgement email on page 57.

How the program handles a bounced email depends on the type of delivery failure.

- If the bounce error is caused by a temporary failure such as a network error, full mailbox, or content filter, the program tries to send the email again periodically for up to 8 hours. For a message or newsletter, you can view the latest bounce information on the Recipients tab on the Message Report or Issue Report screen. For an acknowledgement, you can view the latest bounce information on the Messages tab on the Acknowledgement Report screen.

Note: If an Acknowledgement email bounces due to a temporary failure, you can click Click here to resend in the Action column to attempt to send the email again.

- If the bounce error is caused by a permanent failure, such as an unknown user or address, the account is marked invalid. You can also view bounce information about these accounts in Invalid accounts. For information about how to manage your invalid accounts, see Invalid Accounts on page 75.

Note: To prevent your email address from being blacklisted, the program does not send email to an account that is marked invalid.

Export bounced email details

You can export the information that appears on the Recipients tab grid as a *.csv file. The details for each message include the bounce error, if any, that appears when you click Click here to view detailed bounce information in the Actions column of the grid.

1. From the Message Report screen, select the Recipients tab.
2. Click the Export to .CSV button. You can open the file or save it to a new location.

Note: You can export only information that appears in the grid. If you filter the entries, you limit the information you can export to the *.csv file.

Email Delivery Status

When you send an email, the program prepares the email, retrieves any merge data from other Blackbaud programs, processes the email, and then uploads the email to the Blackbaud Internet Solutions mail server to be sent to its recipients.

After you send an email, you can view the current status of the sent message or newsletter issue. To view the delivery status of an email, access its Message Report or Issue Report screen and select the Summary tab. In the Delivery status frame, the Status field displays the current status of the email. For
information about the Summary tab, see View sent email statistics on page 38 or View the tabs of a sent newsletter issue on page 51.

- “Created” – The email is created but is not yet prepared for processing.
- “Prepared” – The email is in the queue to be processed.
- “Processing” – The email is being processed. This includes retrieving merge data from another Blackbaud program.
- “Processed” – The program processed the email, and it is in the queue to upload to the mail server.
- “No Valid Recipients” – The email cannot be delivered to the selected email list. For example, the email list may not contain any recipients or its recipients may not have valid email addresses.
- “Uploading” – The website is uploading the email to the Blackbaud Internet Solutions mail server.
- “Upload Failed” – The website could not upload the email to the mail server. When this happens, the website automatically tries to upload the email again.
- “Accepted” – The mail server received the email and put it in the queue to be processed.
- “Active” – The mail server is processing the email to prepare it for delivery.
- “Completed” – The mail server processed the email, and it was sent or is in the queue to be sent.

Note: When the Status field displays “Completed,” the mail server may be in the process of sending the email to its recipients. Some messages or newsletter issues in the email may not yet be sent.

- “Exception” – The email could not be uploaded to the Blackbaud Internet Solutions mail server due to an error when the website processed the email.
- “Exception on Server” – The email could not be sent due to an error on the Blackbaud Internet Solutions mail server.
- For Support assistance, visit Blackbaud’s website.

Newsletters

In Newsletters, you can create a newsletter template for each type of newsletter you send by email. For example, you can create a newsletter for your alumni and another for your foundation donors. Within each saved newsletter, you can generate the current issue of the newsletter to send from the Issues tab. After you send the issue via email, the program stores the newsletter on the Issues tab for reference.

Note: Newsletters are sent only to users who subscribe to the newsletter on the User Email Preferences Form. For more information about the User Email Preferences Form part type, see the Parts Guide.

To share with users what newsletters are available, we recommend you link the page users are directed to after they register to the Email Preferences page so they can subscribe to mailings as soon as they register. You can also include information about newsletters in email messages with a link to the Email Preferences page.

Warning: It is important your organization assigns full Administrator rights to only a select number of users for Newsletters. Any change can affect multiple web pages. We strongly encourage only users knowledgeable in all areas of website design and this program perform tasks in Newsletters.
Design a newsletter

1. From Email, click Newsletters. Newsletters appears.
2. Click New newsletter. The New newsletter page appears.

3. On the Properties tab, enter a name in the Newsletter name field.
4. In the Description field, enter additional information, such as notes about the template layout.

   **Note:** The Send to field is disabled. The program automatically generates a mailing list that includes only users who subscribe to the newsletter on the User Email Preferences Form.

5. In the Subject, From Name, and From Address fields, enter a default subject for the Subject field of newsletters you create with this template, as well as an email address and name for the From field. When you create individual newsletters, you can overwrite the subject.
6. To receive responses at a different email address than the one you use to send the newsletter, enter a return address in the Reply address field.
7. To receive failure messages when email messages are not delivered, select Failure to send notification. In the Notification email address field, enter an email address to receive failure messages.

   **Note:** Failures are email addresses that do not receive the newsletters. Failure can also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status Notifications (DSN). For information about how the program handles failures, see Bounced Email Management on page 43.
8. To assign the security rights for the newsletter, select the Targeting & Security tab. For each user role, you can manage rights to view, edit, delete, and change security.
9. To add users or roles, click **Add users and roles**.
10. To assign rights, select **View**, **Edit**, **Delete**, or **Change Security**.

   **Note:** Edit rights allow users to edit the newsletter template and its defaults. To create newsletters from this template, users only need View rights.

   For more information about security and user roles, see the *Users & Security Guide*.

11. Click **Save**. The newsletter template opens to the Design tab.

12. To format the appearance and enter the default content for the newsletter, use the HTML editor. For information about the HTML editor, see the *Program Basics Guide*.

**Warning:** To communicate your website’s privacy policy and to provide a global opt-out option from your email communications, you must include links to the privacy page specified in *Sites & settings* and to a User Email Preferences Form part on a web page when you design a newsletter. This also applies to newsletters you design for the Anonymous Newsletter Subscription part so anonymous recipients can also review your privacy policy and have the option to opt out of the
13. To have personalized information from another program appear in the newsletter for each recipient, add merge fields. For example, when you select the First name field, recipients receive a newsletter addressed directly to them.

   a. To display the list of available merge fields, click Merge fields on the Insert tab in the toolbar.
   b. To add a field to the newsletter, double-click or drag and drop a field in the content area.
   c. Put fields where you want them to appear in the body of the newsletter. For example, enter “Hello, First Name” after it. In the email, the recipient reads “Hello, [his or her first name].” To move a field, click and drag it to the new location.

14. To add conditional content to the newsletter to customize it for different types of recipients, click Conditional content on the Insert tab in the toolbar. For more information about conditional content, see Add Conditional Content on page 23.

15. To format the newsletter’s appearance and layout, use the HTML editor.

   Warning: Blackbaud recommends that you use inline styles, such as `<div style="background-color:Blue;">Welcome color</div>`, when you create and design the email content. Do not define classes or use external references because email vendors, such as Gmail or Outlook, are not guaranteed to render the styles correctly when the recipient reads the email.

16. Click Save.

17. To send an issue of the newsletter, select the Issues tab. For information about how to send an issue from the Issues tab, see Design and send an issue of a newsletter on page 48.

18. To return to Newsletters, click Return.

Design and send an issue of a newsletter

1. From Email, click Newsletters. Newsletters appears.

2. To search for a newsletter, enter its name or subject in the filter fields and click Filter. The newsletters that match your criteria appear.

   Note: The grid displays up to 50 results at a time. If you have more than 50 results, click Prev or Next to page through the results.

3. Select a newsletter and click Click here to edit this newsletter. The Issues page appears.

5. In the Name and Subject fields, enter a name for the issue of the newsletter and a subject in the Subject field of the email message.

6. In the Issue Date field, enter when you created the issue. By default, the current date and time appear.

7. In the Send After Date field, enter when to send the issue. By default, the current date and time appear. However, you can schedule the newsletter for a future date or time. For example, you may be out of the office for the next month but need to send your regular weekly newsletter during that time.
   - To send the issue at a future date or time, enter the date and time. After you design the newsletter, click Send final. The website does not process the email until the date and time you enter.

   If you delete the issue before the date you enter in the Send After Date field, the program does not process the issue and it is not sent to recipients.

   **Tip:** When you delete a newsletter issue, it removes from the user interface, but it remains in the database. To run a process that improves performance by permanently deleting these issues, schedule the Delete email permanently setting in Administration. For more information, refer to Delete email permanently on page 1.
   - To send the issue immediately, leave the current date and time. After you design the newsletter, click Send final. The website processes the email.

   **Note:** Whether you schedule to send the issue of a newsletter in the future or immediately, you cannot edit it once you click Send final.

8. In the Send To field, the newsletter list automatically appears so the issue only sends to subscribed users.
Note: If recipients do not want to receive your email newsletter, they can unsubscribe from the email list. To enable a recipient to unsubscribe, use the Formatted Text and Images part type to create an unsubscribe footer. For more information, see the Parts Guide.

To send the newsletter issue to test recipients before you send it to its final recipients, select the email lists of test recipients to include on the message.

Note: Before you send a newsletter issue to its final recipients, we recommend you first send it to an email list of a few test recipients. The test list recipients can review the newsletter, such as to verify its design displays correctly in multiple email client readers. You can create the email list of test recipients in Lists. For more information about test email lists, see Test Lists on page 74.

a. Click Test Lists. The Select Test Lists screen appears.

b. Enter criteria to narrow the list and click Filter. The grid displays the lists that meet the criteria.

c. To add a test list to the message, select it and click Add. The list appears in the Selected lists box. You can include multiple email lists.

d. Click OK. You return to the New issue page.

9. Edit the default newsletter for this issue. You can edit the layout, design, and text, as well as add or edit articles.

10. Click Save.

11. Send the issue of the newsletter.
• If the issue includes an email list of test recipients, send the newsletter to the test recipients. 
  Click Send test. Depending on the size of the selected test list, the issue may take a few 
  minutes to send. When the program sends the newsletter issue, you return to Newsletters.

After the test recipients verify the newsletter issue and its components look and work correctly, 
send the email to its final recipients. From Newsletters, click Click here to edit this newsletter. 
On the Issues tab, click Click here to edit this newsletter issue. When the issue opens, click Send final.

• To send the issue to its final target recipients now, click Send final. The website processes the 
  message at the date and time entered in the Send after date field.

• To send the issue to the test or final recipients at a later time, click Return. You return to 
  Newsletters. To send the issue, click Click here to edit this newsletter. On the Issues tab, click 
  Click here to edit this newsletter issue. When the issue opens, click Send test or Send final.

Note: Each email sent contains a text version in addition to its HTML-formatted version. Email client 
readers set to display text only show either this text version of the email or its own text version, 
generated from the HTML. The text version of the email cannot be altered.

View the tabs of a sent newsletter issue

1. From Email, click Newsletters. Newsletters appears.
2. Select a newsletter and click Click here to edit this newsletter. The Issues page appears.
3. On the Issues tab, select an issue of the newsletter and click Click here to view report. The 
   issue report screen appears.

Note: To create an issue based on an existing issue, you can click Click here to copy this 
newsletters issue. For information about how to design an issue of a newsletter, see Design and 
send an issue of a newsletter on page 48.

Note: If Click here to view report does not appear, the program has not sent the issue.
4. On the Issue report tab, you can view summary information and statistics about the issue on a 
   series of tabs.
   • The Delivery summary tab displays the status of the issue and how many recipients it was sent 
     to. For information about the email statuses, see Email Delivery Status on page 44.
   • On the Issues sent tab how newsletters were opened, not opened, and not delivered. 
     “Opened” indicates the recipient displayed the newsletter’s images or clicked a link in the 
     email.
     “Not opened” indicates the newsletter was delivered but the recipient did not display its 
     images or click a link.
     “Not delivered” indicates the newsletter “bounced,” or could not be delivered. Email delivery 
     may fail for multiple reasons, such as a temporary network issue, a full mailbox, a content filter, 
     or an invalid account. For information about bounced email, see Bounced Email Management 
     on page 43.

Note: If delivery fails because the recipient’s Internet Service Provider (ISP) reports that the email 
address is invalid, the email address is automatically added to Invalid accounts. An ISP considers an 
account invalid if it does not recognize the email address or recipient. For information about 
Invalid accounts, see Invalid Accounts on page 75.
• The Issues not sent tab displays how many newsletters were not sent because of opt-outs, missing addresses, and invalid accounts.

**Note:** The Issues not sent tab does not appear if the program sends all copies of a newsletter.

To prevent your email address from being blacklisted, the program does not send email to invalid accounts. For information about invalid accounts, see Invalid Accounts on page 75.

• The Click-throughs tab displays all web pages that the newsletter links to, along with how many times recipients click the links and how many unique recipients click the links. For example, if you include a link to an events page, it appears in the grid on the Click-throughs tab. If a recipient clicks that link three times, the **Total views** column for the events page increases by three and the **Unique viewers** column increases by one.

To track click-throughs, the program associates email IDs with email messages. When you include a link in an email message, the program appends a destination link value that includes the email ID to the site URL that you specify in Sites & settings. When an email recipient clicks the link, the program redirects the user to the page through the site and then associates any resulting activity with the email ID.

• The Conversions tab displays how many transactions your organization receives as a result of the newsletter. Conversions include donations, and event registrations.

For each type of conversion, the tab displays the payment methods used in response to the newsletter, along with the number of transactions for each method and the total amount of those transactions.

• If the newsletter included conditional content, the Conditional Content tab displays statistics about how each condition in a content block performed. It includes the number of recipients that received the condition, the number who opened the email, the number of click-throughs, the number of conversions (transactions), and the total gift amounts. For information about conditional content, see Add Conditional Content on page 23.

5. For additional summary information about your email message, view the Email Status Report. To generate this report, click Status report. The Email Status Report screen appears and displays valuable information about your email, such as a “[Prepared]” date and time stamp.

6. To view who received the issue, select the Recipients tab.

7. In the grid, view the address that the program sends the email to for each recipient. You can limit the addresses that appear in the grid.

   a. In the Filter list by frame, enter the criteria of the address to view. You can enter the name of the recipient, email address, or email type.

   b. Click Go. In the grid, the addresses that meet the criteria entered appear.

8. For each email address, view the name of the recipient, when the program sent the email, and when the email was open or bounced.

   • If an email message cannot be delivered to a recipient, the **Bounced** column displays the bounce details.

   • If the recipient opens the email message, the **Opened** column displays the receipt details.

9. To open a constituent record offline, select a recipient and click **Click here to open this recipient**. If the link does not appear for a user mapped to Blackbaud CRM, make sure a Blackbaud CRM constituent page appears in the **Blackbaud Internet Solutions link page** field when you configure integration in Blackbaud CRM.
10. If the program cannot deliver an issue, click **Click here to view detailed bounce information** in the **Actions** column to view the bounce error. The Bounce Information screen appears and displays the exact wording of the bounce error. You can use this information to help determine the cause of the bounce error. For more information about bounced email, see **Bounced Email Management on page 43**.

11. To view the properties and content of the issue, select the Properties tab.

12. In the **Job details** frame, view information such as whom the issue was sent to and from and the sent date.

13. In the **Message content** frame, view the body of the issue.

14. To leave the Issue Report screen, click **Return**.

**Acknowledgements**

**Note:** This functionality is deprecated. In current versions, all acknowledgements on new forms are created with a standard default message that is stored in the database and is non-configurable. To modify acknowledgement text for a part, navigate to the part type that uses the acknowledgment functionality and update the message that appears.

You can generate acknowledgement email from part types that contain acknowledgement functionality. For example, you generate acknowledgements from the Donation Form part. **Acknowledgements** contains the default acknowledgement email for your website. You can use this email as the default template for acknowledgement email for part types. In addition, you can view acknowledgement email statistics from **Acknowledgements**.

**Warning:** It is important your organization assigns full Administrator rights to only a select number of users for **Acknowledgements**. Any change can affect multiple web pages. We strongly recommend only users knowledgeable in all areas of website design and the program perform tasks in **Acknowledgements**.

To prevent acknowledgements from inadvertently sending from a test environment, your System Administrator can use the setting BlockAllEmails in both web.config files for Blackbaud Internet Solutions and Blackbaud CRM to block sending them. By default, this setting is `<add key="BlockAllEmails" value="False" />`. To prevent sending messages, you must enter True in each web.config file for both programs.

**Design a default acknowledgement email**

1. From **Email**, click **Acknowledgements**. **Acknowledgements** appears.

2. Beside the Acknowledgement Defaults email, click **Click here to view/edit this acknowledgement’s properties**. The Acknowledgement Defaults page appears.
3. On the Properties tab, enter an email address and name for the From field of the email message.

4. To receive responses at a different email address than the one you use to send the message, enter a return address in the Reply address field.

5. Under Notifications are to be sent to the following addresses, select Failures to receive failure messages when email messages are not delivered. In the field beside the checkbox, enter an email address to receive failure messages.

   **Note:** Failures are email addresses that do not receive the acknowledgement email. Failures can also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status Notifications (DSN). For information about how the program handles failed email delivery, see Bounced Email Management on page 43.

6. Under Template Security, assign the security rights for the acknowledgement. For each user role, you can manage rights to view, edit, delete, and change security.

7. To add users or roles, click Add users and roles.

8. To assign rights, select View, Edit, Delete, or Change Security.

   **Note:** Edit rights allow users to edit the template and its defaults. To create email messages from this template, users only need View rights.

   For more information about security and user roles, see the Users & Security Guide.

9. To design the content and appearance of the acknowledgement, select the Content tab.
10. Enter the default text for all acknowledgement email. When you create an acknowledgment email sent from the Donation Form or Event Registration Form part types, this text automatically appears.

11. To format the default content’s appearance and layout, use the HTML editor. For information about the HTML editor, see the Program Basics Guide.

**Warning:** Blackbaud recommends that you use inline styles, such as `<div style="background-color:Blue;">Welcome color</div>`, when you create and design the email content. Do not define classes or use external references because email vendors, such as Gmail or Outlook, are not guaranteed to render the styles correctly when the recipient reads the email.

**Note:** You do not add merge fields on the acknowledgement default email template. Merge fields are available for the individual email message created from donation parts.

12. Click **Save**.

13. To return to **Acknowledgements**, click **Return**.

**Design an acknowledgement email for a transaction**

You can generate an acknowledgement from part types that contain acknowledgement functionality, such as the Donation Form part or Event Registration Form part. The acknowledgement appears on your website after the site user completes a transaction. In addition, this message is automatically sent in an email to the site user. For the site user to receive an acknowledgement, you must design and create an acknowledgement email for the part type.

1. From the Edit Part screen, access the Acknowledgement Email screen.
Note: How to access the Acknowledgement Email screen depends on the part. For example, on an Event Registration Form part, you click Acknowledgement email, while on a Donation Form part, you click Next after you design the rest of the form.

Note: The screen shown above is the Acknowledgement Email screen for an Event Registration Form part. Depending on the part type you use, your Acknowledgement Email screen may differ slightly.

Note: For Payment parts, you create a summary acknowledgement email. If you select to send the summary acknowledgement on both the Payment part and the Donation or Event Registration parts that use the Payment part, a donor receives one email that details all transactions, rather than separate acknowledgement emails for each payment the donor makes during a visit to your website. For information about how to send a summary acknowledgement email, see the Parts Guide.

1. Enter a name for the acknowledgement, a subject to include in the Subject field of the email message, and an email address and name to include in the From field of the email message.

2. To receive responses from recipients at a different email address than the one you use to send the message, click More Options and enter the address in the Reply Address field.

3. Under Notifications are to be sent to the following addresses, select Failures to receive failure messages when email messages are not delivered. In the field beside the checkbox, enter an email address to receive failure messages.

Note: Failures are email addresses that do not receive the acknowledgement email. Failures can also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status Notifications (DSN). For information about how the program handles failures, see Bounced Email Management on page 43.

4. If this part uses a Payment part, you can select whether to send a summary acknowledgement email. This email details all donations or event registrations payments the donor makes with the Payment part during a visit to your website.
• Select **Send this acknowledgement email only when a summary email is not available** to send the Payment part’s summary acknowledgement email. If the part does not use a Payment part, the donor receives the acknowledgement email you create on this screen.

• Select **Always send this acknowledgement email** to send the email you create for this part. If the part uses a Payment part with the summary acknowledgement email option selected, the donor receives both individual and summary acknowledgement emails.

6. In the box, the text from the default acknowledgement email appears. To enter or edit the content of the email as required, use the HTML editor. For information about the HTML editor, see the *Program Basics Guide*.

To customize email content, click **Merge fields** on the Insert tab in the toolbar. To format the email content’s appearance and layout, use the HTML editor.

**Note:** You can include conditional fields in your acknowledgement email. Conditional fields do not appear in the final email if they do not apply to the transaction being acknowledged. For example, for a donation acknowledgement, you can enter “We greatly appreciate **<Company Name>**’s support!” If the donation is not from a company, this sentence does not appear in the final acknowledgement. To identify conditional fields, look for “begin section” and “end section” indicators. For example, `<Corporate.Begin Section>` and `<Corporate.End Section>` indicate that the sentence with `<Company Name>` is conditional.

7. Click **Save**. You return to the Edit Part screen.

8. Click **Save**. You return to **Parts**.

> **View the tabs of a sent acknowledgement email**

1. From **Email**, click **Acknowledgements**. **Acknowledgements** appears.

2. Select an acknowledgement and click **Click here to view report**. The acknowledgement report appears.

3. On the Acknowledgement report tab, you can view summary information and statistics about the acknowledgement on a series of tabs.

   • The Delivery summary tab displays the status of the email and how many recipients it was sent to. For information about email statuses, see *Email Delivery Status on page 44*.

   • The Acknowledgements sent tab displays how many acknowledgements were opened, not opened, and not delivered.

   “Opened” indicates the recipient displayed the acknowledgement’s images or clicked a link in the email.

   “Not opened” indicates the acknowledgement was delivered but the recipient did not display its images or click a link.

   “Not delivered” indicates the acknowledgement “bounced,” or could not be delivered. Email delivery may fail for multiple reasons, such as a temporary network issue, a full mailbox, a content filter, or an invalid account. For information about bounced email, see *Bounced Email Management on page 43*.

**Note:** If delivery fails because the recipient’s Internet Service Provider (ISP) reports that the email address is invalid, the email address is automatically added to **Invalid accounts**. An ISP considers an account invalid if it does not recognize the email address or recipient. For information about **Invalid accounts**, see *Invalid Accounts on page 75*. 
• The Acknowledgements not sent tab displays how many acknowledgements were not sent because of missing addresses and invalid accounts.

**Note:** The Acknowledgements not sent tab does not appear if the program sends all copies of an acknowledgement.

To prevent your email address from being blacklisted, the program does not send email to invalid accounts. For information about invalid accounts, see *Invalid Accounts on page 75.*

• The Click-throughs tab displays all web pages that the acknowledgement links to, along with how many times recipients click the links and how many unique recipients click the links. For example, if you include a link to an events page, it appears in the grid on the Click-throughs tab. If a recipient clicks that link three times, the **Total views** column for the events page increases by three and the **Unique viewers** column increases by one.

To track click-throughs, the program associates email IDs with email messages. When you include a link in an email message, the program appends a destination link value that includes the email ID to the site URL that you specify in *Sites & settings*. When an email recipient clicks the link, the program redirects the user to the page through the site and then associates any resulting activity with the email ID.

4. To view the acknowledgement’s recipients, select the Messages tab. The grid displays names and email addresses of recipients, along with dates and times for when the program sent the email and when it was opened or bounced.

**Note:** Users continue to receive acknowledgement emails even if they select the global opt-out checkbox on your user email preferences form.

5. To search for a recipient, enter a name or email address or select a status, and click **Filter**. The recipients that match your criteria appear.

• If a recipient opens the email message, receipt details appear under **Opened**.

• If an email message cannot be delivered, bounce details appear under **Bounced**. To view the bounce error, click **Click here to view detailed bounce information**. The Receipt Information screen displays the bounce error. You can use this information to help determine the cause. For information about bounced emails, see *Bounced Email Management on page 43.*

• If an email address is invalid, “No Valid Recipients” appears under **Status**. For information about how to manage invalid accounts, see *Invalid Accounts on page 75.*

6. To open a constituent record offline, select a recipient and click **Click here to open this record**. If the link does not appear for a user mapped to Blackbaud CRM, make sure a Blackbaud CRM constituent page appears in the **Blackbaud Internet Solutions link page** field when you configure integration in Blackbaud CRM.

7. To open a website user’s online record, select a recipient and click **Click here to view this user’s record**. The User editor page in *Users & security* appears.

8. To return to **Acknowledgements**, click **Return**.

**Notifications**

A notification is an email message designed to notify constituents or staff members about a specific action. For example, a website user can select to send a notification when he receives a new personal
message, friend request, or group invitation. A staff member can receive a notification when a website user submits a donation.

You create and design most notifications in Notifications. However, you can also design and edit associated notification types on some parts. For example, you can create user network notifications when you design the User Networking Manager part.

**Note:** Even if a user selects the global opt-out checkbox on your website to decline email communications, she continues to receive requested notifications.

#### Design a constituent notification

**Tip:** When you create a notification, consider the email volume recipients will receive. For example, if you are expecting a high volume of donations on your website, you may not want to create a notification for those transactions because the recipients will receive numerous email notifications.

1. From *Email*, click **Notifications**. *Notifications* appears.

2. Click **New notification**. The Select Notification Type screen appears.

3. Select whether the notification is for a constituent or a staff member.

4. In the **Notification Type** field, select the type of constituent notification to create.
   - To create a notification for a user networking member who receives a personal message from another member, select “Personal Message Notification.”
   - To create a notification for a user networking member who receives a request from another member to be in a contact list, select “Friend Request Notification.”
   - To create a notification for a user networking member who receives an invitation to join a user networking group, select “Group Invitation Notification.”
   - To create a notification for a user networking member who receives a personal message from another member sent from the directory results, select “Directory Message Notification.”

5. Click **OK**. The New Notification page appears and defaults to the Notification tab.
6. In the Display name field, edit the name of the notification so that users can identify it. By default, the notification type appears.

7. When you no longer want to send the notification to recipients, clear Enabled.

*Tip:* As you create the notification, consider the email volume the notification will generate. For example, if you expect a high volume of donations on your website, recipients are likely to receive numerous emails from a transaction donation notification. To avoid sending a large volume of email notifications to recipients, clear Enabled to disable the notification until donation transactions return to normal.

8. Under Parts, select the checkbox for each part to use the constituent notification.

9. To design the email, select the Email template tab.
10. Enter a subject in the **Subject** field and an email address and name in the **From** fields for the email message.

**Note:** You cannot view the notification template in **Templates**. You can only access it from **Notifications**.

11. The bottom pane displays default text for the notification. You can use this text or enter your own. To format the appearance and layout, use the HTML editor. For more information, see the **Program Basics Guide**.

**Warning:** Blackbaud recommends that you use inline styles, such as `<div style="background-color:Blue;">Welcome color</div>`, when you create and design the email content. Do not define classes or use external references because email vendors such as GMail and Outlook are not guaranteed to render the styles correctly when the recipient reads the email.

To personalize the email with offline information about the constituent, add merge fields.

a. To display the list of available merge fields, click **Merge fields** on the Insert tab in the toolbar.

b. To add a merge field to the email, double-click it or drag and drop the field in the content area.

c. In the body of the email, add fields where you want them to appear. To move a field, click and drag it.

12. Click **Save**. You return to **Notifications**.

**Design a staff notification**

**Tip:** When you create a notification, consider the email volume recipients will receive. For example, if you are expecting a high volume of donations on your website, you may not want to create a
notification for those transactions because the recipients will receive numerous email notifications.

1. From Email, click Notifications. Notifications appears.
2. Click New notification. The Select Notification Type screen appears.
3. Select Staff notification.

![Select Notification Type](image)

4. In the Notification Type field, select the type of staff notification to create.
   - To create a notification for a staff member in the approval role when someone submits a Formatted Text and Images or Formatted Text and Images (Secured) part for approval, select “Part Approval – Ready for Approval Notification.”
   - To create a notification for a content author staff member whose Formatted Text and Images or Formatted Text and Images (Secured) part is approved, select “Part Approval – Published Notification.”
   - To create a notification for a content author staff member whose Formatted Text and Images or Formatted Text and Images (Secured) part is rejected, select “Part Approval – Rejected Notification.”
   - To create a notification for a staff member when a website user submits a donation, select "Transaction – Donation Notification."

Note: The program sends this notification when a user submits a donation on the Donation Form, Payment, or Payment 2.0 parts.

   - To create a notification for a staff member when a website user submits an event registration, select "Transaction – Event registration notification.”

5. Click OK. The New Notification page appears and defaults to the Notification tab.
New Notification

Transaction - Donation Notification. Sends an email when someone submits a donation.

**General**

- Display name: *Transaction - Donation Notification*
- Enabled: [ ]

**Recipients**

- Roles:

  Select all | None + Add roles

  Email addresses: ??

**Parts**

Select the parts to use this notification

[ ] Donation form
6. In the **Display name** field, edit the name of the notification so that users can identify it. By default, the notification type appears.

7. When you no longer want to send the notification to recipients, clear **Enabled**.

**Tip:** As you create the notification, consider the email volume the notification will generate. For example, if you expect a high volume of donations on your website, recipients are likely to receive numerous emails from a transaction donation notification. To avoid sending a large volume of email notifications to recipients, clear **Enabled** to disable the notification until donation transactions return to normal.

8. Under **Recipients**, to send the notification to staff members in a role, click **Add roles**. The Select Roles screen appears so you can include one or more roles.

   a. To send the notification to an individual staff member, enter an email address under **Email addresses**.

**Note:** You can select to send the notification to staff members in roles instead of, or in addition to, staff members you enter email addresses for. When you enter multiple email addresses, separate them by a comma or semicolon.

9. When you design a transaction notification, such as "Transaction – Donation Notification," under **Parts**, select the checkbox for each part to use the staff notification.

   When you design a "Part Approval" notification, such as "Part Approval – Ready for Approval Notification," under **Workflows**, select the checkbox for each workflow to use the staff notification.

10. To design the email, select the **Email template** tab.

11. Enter a subject in the **Subject** field and an email address and name in the **From** fields for the email message.
Note: You cannot view the notification template in Templates. You can only access it from Notifications.

12. The bottom pane displays default text for the notification. You can use this text or enter your own. To format the appearance and layout, use the HTML editor. For more information, see the Program Basics Guide.

Warning: Blackbaud recommends that you use inline styles, such as `<div style="background-color:Blue;">Welcome color</div>`, when you create and design the email content. Do not define classes or use external references because email vendors such as Gmail and Outlook are not guaranteed to render the styles correctly when the recipient reads the email.

To personalize the email with offline information about the constituent, add merge fields.

a. To display the list of available merge fields, click Merge fields on the Insert tab in the toolbar.

b. To add a merge field to the email, double-click it or drag and drop the field in the content area.

c. In the body of the email, add fields where you want them to appear. To move a field, click and drag it.

13. Click Save. You return to Notifications.

View the tabs of a notification

1. From Email, click Notifications. Notifications appears.

2. To search for a notification, enter criteria to narrow the list in the grid and click Filter. The notifications that match your criteria appear.

3. Select a notification and click Click here to edit this Notification. The notification appears.
4. Edit the notification as necessary. For information about the Notification and Email template tabs, see Design a constituent notification on page 59 or Design a staff notification on page 61.

**Note:** You cannot change the notification type. To do this, you must delete the notification and create a new one. For information about how to delete a notification, see Delete a notification on page 66.

5. Click **Save**. You return to **Notifications**.

To return to **Notifications** without saving any changes, click **Return**.

**Delete a notification**

1. From **Email**, click **Notifications**. **Notifications** appears.

2. To search for a notification, enter criteria to narrow the list in the grid and click **Filter**. The notifications that match your criteria appear.

3. Select the notification to delete and click **Click here to delete this Notification**. A confirmation message appears.

4. Click **OK**. You return to **Notifications**. The grid no longer displays the notification.

**Lists**

In **Lists**, you can use queries from our programs to create and view email lists. You can create multiple email lists, each one targeted at a different group of your users. For example, you can create an offline query of all constituents in your database who have an attribute of Sports on their records. You can use
the query online to create an email list of constituents interested in sports and invite them to your sporting event fundraisers. In the email message, you can include a link to the page of your website where the recipient can sign up for the event.

**Tip:** We recommend you create a list of users to receive an email message as a test before you send the message to its final recipients. The test list recipients can review the message to verify that the message appears correctly in multiple email client readers. For more information about test email lists, see [Test Lists on page 74](#).

You can use static or dynamic queries but not queries that contain “ask at runtime” operators. If the query is dynamic, the program automatically updates the list in *Lists*. However, if the query is static, the list does not automatically update. To update a list that uses a static query, refresh the query in the other program. For more information about how to create and refresh a query, see the [Query section](#) of the help file of the other Blackbaud program.

The grid in *Lists* contains all email lists created in *Lists* but also those automatically generated when you send a newsletter. Newsletter lists contain only users who subscribe to the newsletter so the generated list name is always “[Newsletter Name] Subscribers.” You can add, delete, and view email lists in the grid.

**Tip:** For best practice information about email, refer to [Blackbaud Communication Services Best Practices for Email](#).

### Create an email list

**Show Me:** Watch [how to create an email list](#).

1. From *Email*, click *Lists*. *Lists* appears.
2. Click **New list**. The Select Data Source screen appears.
3. In the **Data Source** field, select the type of recipients to include in the list. The data source determines the pool of people that are available.

- To create a list of recipients based on a constituent query, select "Constituents." From the Properties tab, click **Add query** to select a constituent query created in your offline database. When you select this option, the recipients include only constituents who are individuals. To include constituents that are organizations, you must select "Imported Lists" as the data source and choose an import file that contains the organizations to include.

Individuals in a "Constituents" data source list must have an email address that matches the type selected in the **Email address type** field on the template or message. Otherwise, the message is sent automatically to the primary email address on the individual's constituent record. When an individual's record is marked **Requests no email**, the individual is excluded from the list and does not receive the email message.

In Blackbaud CRM, a record is created for the email messages that you send to a list with the "Constituents" data source. And if recipients opt out of future email communications, this is noted on their constituent records.

When you use a Constituent or Imported List, and you want to send one email to multiple recipients with the same email address, clear the **Send a unique email to each constituent who shares the same email address** checkbox in **Sites & settings**. You typically select this when you want constituents, such as parents and children, who share email addresses to each receive a copy of messages. For more information, refer to the **Administration Guide**.

- To create a list of recipients that includes all your Blackbaud Internet Solutions users, select "Registered Users." This source includes all registered website users who did not opt out of email communications, including those who are linked to constituents.

**Note:** Only users with Supervisor rights can select "Registered Users."

Email messages to a list with the "Registered Users" data source are not recorded in Blackbaud CRM. If recipients opt out of email communications, this is noted in Blackbaud Internet Solutions but not on constituent records in Blackbaud CRM.

- To create a list based on information you will import from a list in *.*csv format, select "Imported Lists." From the Properties tab, click **Browse** under **Load file** to search for the file to import. After you select an import file, click **Next**. Under **Field mapping**, select the import file fields that correspond to the email and display name fields in your online database.

**Note:** If you previously linked an import file to the list, click **Replace this file** under **Uploaded file details** to select a different import list. This button is available until you use the list to send an email from **Messages**. The program removes the **Replace this file** option when you use the list as the data source for **Templates**.

- To create a test list for a limited number of recipients, select “User Defined.” For example, before you send a mass email, you may want to send the message to accounts you have with different email services to determine how the text and graphics appear in the email client readers. From the New List screen, you can enter a name for the list and a description. Click **Save**, then open the new list. From the View/Edit List tab, enter each recipient to include. Select **Enabled** to allow the recipient to receive the message.

4. Click **OK**. The New List page appears.
5. On the Properties tab, the **Data Source** field displays the data source you selected.

*Tip:* You also select a data source on each email template. Messages created from the template can be sent to only lists that use the same type of data source. For more information, see [Template Data Sources on page 20](#).

6. In the **List Name** field, enter a unique name to distinguish this group for specific email messages, such as “Class of 1994.”

7. In the **Description** field, enter any additional information. For example, enter a brief description of who the mailing list includes or the types of email messages this list receives, such as “Class of 1994 Alumni.”

When a user creates an email in *Messages* and clicks **Send to**, the program displays all saved email lists that the user has security rights to.

8. If you select “Constituents” as the data source, the **Constituent Queries** frame appears.
• To add a query, click **Add Query**. The Query Search screen appears. Select a query for the email list. For a query to appear as a selection, it must first be created in the other program.

To add another query, click **Add Query**. You can add queries until you select all queries required for the email list.

**Tip:** Depending on your website environment and configuration, sending an email message to a large list of recipients may result in performance issues. If you experience this, we recommend you include smaller queries in the list. You can also remove queries from the list.

• To replace a query, click **Change** beside the query. The Query Search screen appears.

• To remove a query, click **Remove** beside the query.

9. If you select “Imported Lists” as the data source, the **Load File** frame appears. In the **File** field, select the comma-separated values (*.csv) file to import for the email list. To map to the location of the import file, click **Browse** and use the Choose File screen.
Note: The first row of the imported *.csv file must contain the field names.

After you select the import file, the **Uploaded file details** and **Field mapping** frames appear.

a. In the **Uploaded file details** frame, the **File name** field displays the selected import file. To import a different file, click **Replace this file**. The **Load file** frame appears.

b. In the **Field mapping** frame, select the fields from the import file to use as the email address and recipient display name in the email list.

10. To assign security rights for the list, select the Targeting & Security tab. For each user role, you can manage rights to view, edit, delete, and change security.

11. To add users or roles, click **Add users and roles**.

12. To assign rights, select **View**, **Edit**, **Delete**, or **Change Security**.

   For more information about security and user roles, see the **Users & Security Guide**.

13. Click **Save**. You return to **Lists**.
View the tabs of an email list

1. From Email, click Lists. Lists appears.
2. Select a list and click Click here to edit this list. The list appears.
3. To view the messages created based on the email list:
   a. Select the List Messages tab.
   b. Under Filter list by, enter the criteria of the messages to view. You can enter the message’s name or subject. You can also select to view results by the template used.
   c. Click Go. The grid displays the messages that meet the criteria.

Note: The grid can display up to 50 results at a time. If you have more than 50 results, click Prev or Next to page through the results, or select the page number to view.

4. To view the properties and security settings entered when the list was created, select the List Properties tab. To help you navigate through the information, the List Properties tab contains the Properties and Targeting & Security tabs.
On the Properties tab, view the data source, list name, description, and the queries or load file entered when the list was created.

When you host multiple sites, the **Assign to site** field appears on the Properties tab so you can move a list from its current site to another site. If the list is in use on the source site, it continues to be on that site. However, the list is now associated with the target site and its security.

On the Targeting & Security tab, view the security rights assigned to each user of the email list.

5. If the email list is based on a query of records, the View List tab appears. To view the recipients included in the list:
   a. Select the View List tab.
b. Under **Filter list by**, enter the criteria for the record to view. You can enter the record’s display name or email address. You can also select to view results by the source query or email status or whether to view opt-outs.

**Note:** If you create a query in another program, you may need to refresh Blackbaud Internet Solutions for it to appear as a selection. To refresh, select View, Refresh from the menu bar.

**Note:** If you create a query in another area, you may need to refresh for it to appear as a selection. To refresh, select View, Refresh from the menu bar.

c. Click Go. The grid displays the records in the list that meet the criteria.

**Note:** The grid can display up to 50 results at a time. If you have more than 50 results, click Prev or Next to page through the results, or select the page number to view.

6. To view the email templates created that use the email list:

a. Select the List Templates tab.

b. In the **Filter list by** frame, enter the criteria for the template to view.

c. Click Go. The grid displays the templates that meet the criteria.

**Note:** The grid can display up to 50 results at a time. If you have more than 50 results, click Prev or Next to page through the results, or select the page number to view.

7. To return to Lists, click Return.

### Test Lists

In Lists, you can create a list of users to receive an email message or a newsletter issue as a test before you send the email to its final recipients. The test list recipients can review the message or newsletter to confirm that its design displays correctly in multiple email client readers. From Lists, create a list based on the “User Defined” data source. Save the list, then open it and select the View/Edit list tab. From this tab, you can manually enter email addresses for the recipients to receive the test message. When you design the email message or newsletter issue, you can select its test list and perform a test send to the users in the list. For information about how to create an email list, see Lists on page 66. For information about how to design an email message, see Messages on page 32. For information about how to design a newsletter issue, see Newsletters on page 45.

**Note:** Test messages do not display merge field data; placeholders are included where the merge data will appear in the final message. To test merge fields, select the test list in the **To** field and then select **Send final**.
Invalid Accounts

In *Invalid accounts*, you can view email address accounts that have been reported as invalid by their hosting Internet Service Provider (ISP). For example, an ISP may report an email address account as invalid due to a nonexistent or canceled account. Typical causes of an invalid account occur when the email address contains a typographical error or the email account is canceled due to inactivity. Accounts that bounce email for another reason, such as a temporary network issue, a full mailbox, or a content filter, do not appear in *Invalid accounts*.

**Note:** For information about how the program handles accounts that bounce email but are still valid, see Bounced Email Management on page 43.

To prevent your email address from being blacklisted, the program does not send email to invalid accounts. For each email address in *Invalid accounts*, you can view the bounce error that caused the ISP to report the account as invalid. If you think an account was incorrectly marked invalid, you can mark it as valid to include it in mailings.

**View invalid email address accounts**

1. From *Email*, click *Invalid accounts*. *Invalid accounts* appears.

The grid displays any email address that a hosting ISP reports as invalid. The **Attempts** column displays the number of bounce errors you receive for an account, while the **Created** and **Updated** columns display when you receive the first and last bounce errors.

**Note:** The program does not send email to invalid addresses, so typically the **Attempts** column displays a single bounce error and the **Created** and **Updated** columns display the same date and time. However, if you mark an account as valid and it returns a bounce error, the **Attempts** column...
displays multiple bounce errors and the Updated column displays the date and time of the most recent bounce error.

2. To export the email addresses in the grid to a *.csv file, click Export to .csv. You can open the file or select a location to save it.

3. To search for an email address, enter it in the Email address field and click Filter.

4. To view bounce error details, select an account and click the edit icon in the Mark as valid column. The invalid account page appears.

For each bounce error, the grid displays the subject of the email, when you sent the message, when you received the bounce error, and the exact wording of the bounce error you received from the hosting ISP.

5. To mark the account as valid so that you can send email, click Mark as valid. You return to Invalid accounts, the email address no longer appears in the grid. If you send email to the address and the hosting Internet service provider (ISP) reports it as invalid, the email address returns to Invalid accounts.

6. To return to Invalid accounts, click Return.

eCard Templates

eCard templates stores the eCard designs for your website. After you create an eCard template, you can use it with as many parts that contain eCard functionality as you want. For example, you can save a holiday theme eCard in eCard templates and use it with multiple eCards and Donation Form parts. You can provide a selection of eCard templates that website users can personalize and send for free or as an incentive to donate. eCards can also help promote your organization and drive new users to your website. From eCard templates, you manage your organization’s eCard templates in one location.

On the Samples tab, eCard templates also provides sample eCard templates. You can copy these samples to create eCard templates. For information about the sample templates, see Sample eCard Templates on page 86.

Note: eCards do not apply to the BlockScheduledEmails setting in both web.config files for Blackbaud Internet Solutions and Blackbaud CRM. Therefore, if you have this setting set to True to prevent email from sending from a test environment, recipients will continue to receive them.
Design an eCard template

To add an eCard template to an eCards part or Donation Form part that contains eCard functionality, you must first create the template in eCard templates. eCard templates stores the templates within categories. When you add an eCard template, you specify how the template appears on parts and select the categories in eCard templates where it belongs. On your website, users select the template and use it to send personalized eCards to others as email messages.

1. From Email, click eCard templates. eCard templates appears.

   Tip: On the Samples tab, eCard templates provides sample eCard templates. To save time, you can copy a sample template to create an eCard template. For information about how to copy a sample eCard template, see Sample eCard Templates on page 86.

2. Click Add eCard template. The Add eCard template screen appears.

3. Select the Properties tab.

   ![Add eCard template](image)

4. Under Display options, enter how the template appears for users in eCard templates or Parts and on your website.

   a. In the Name field, enter a name so users can identify the eCard template.

   Note: When program and website users browse through eCard templates, such as on the eCards part or your website, the templates appear in alphabetical order by name. When you enter a name for the eCard template, consider where the template name appears when sorted alphabetically.
b. In the **Preview image** field, select the path to the image to use as the thumbnail image for the eCard. To search for the image, click **Browse** and use the Choose file screen. After you map to the image location, click **Open**. You return to the Add eCard Template screen.

**Note:** On your website, the image entered in the **Preview image** field appears as a thumbnail image. The specifications selected on the eCards or Donation Form part determine the size of the thumbnail image on your website.

c. In the **Caption** field, enter the caption text to appear for the eCard template. When a website user hovers the cursor over the thumbnail image of the template, the caption text appears as a tooltip.

5. Under **Email options**, in the **Email subject line** field, enter the subject line to appear for all eCard email messages based on the template. For example, for a seasonal holiday eCard, enter “Happy Holidays!”

6. **eCard templates** stores every eCard template within a category. Under **eCard categories**, select the category the template belongs to. For example, you can store a Happy Holidays eCard under a category of “Holiday.” You can add the template to multiple categories.

- To add the template to an existing category, select its checkbox in the **Categories** box.
- To add the template to a new category, in the **And/or a new category** field, enter the name of the new category.

7. Select the Design tab.

8. Use the HTML editor to format the template’s appearance and layout. For more information about the HTML editor, see the **Program Basics Guide**.

**Warning:** Blackbaud recommends that you use inline styles, such as `<div style="background-color:Blue;">Welcome color</div>`, when you create and design the email content. Do not define classes or use external references because email vendors, such as **Gmail** or **Outlook**, are not guaranteed to render the styles correctly when the recipient reads the email.
Tip: When you design an eCard template, you can insert images from the Image Library. If you reference an image in an eCard template and then remove the image from the Image Library, eCards based on the template cannot display the image.

To allow website users to personalize eCards based on the template with sender and recipient information, add merge fields. To display the list of available merge fields, click Merge fields on the Insert tab in the toolbar. To expand the list, click the plus sign next to eCard fields. For information about the merge fields that appear when you design an eCard template, see eCard Template Merge Fields on page 87.

Note: To allow website users to send a personal message with eCards based on the template, you must include the <Sender’s personal message> merge field. If you do not use this merge field on a template, the option to add a personal message does not appear when the user personalizes the eCard on your website.

9. Click Save. You return to eCard templates.

Edit an eCard template

1. From Email, click eCard templates. eCard templates screen appears.
2. Browse the Categories tab or click the Search tab to find the eCard template to edit.
3. The eCard templates frame displays the templates that meet your criteria.
Note: In eCard templates, you can preview an eCard template to verify it is the one to edit. Under eCard templates, click the image of the template. A larger version of the image appears. To return to eCard templates, click the larger image.

4. Under eCard templates, click Edit under the template to edit. The eCard Template Properties screen appears and opens to the Properties tab.

5. Adjust the display options, subject line, or categories for the eCard template.

   When you host multiple sites, the Assign to site field appears on the Properties tab so you can move a template from its current site to another site. If the template is in use on the source site, it continues to be on that site. However, the template is now associated with the target site and its security.

6. To adjust the design of the eCard template, select the Design tab. Use the HTML editor to format the template's appearance and layout.
For information about how to design an eCard template, see Design an eCard template on page 77.

**Note:** If you adjust the design of an eCard template, the change affects only the eCards that are based on the template and sent after the adjustment. The adjustment does not affect eCards sent before the design change.

7. Click Save. You return to eCard templates.

**Copy an eCard template**

1. From Email, click eCard templates. eCard templates appears.
2. Browse the Categories tab or click the Search tab to find the eCard template to copy.
3. The **eCard templates** frame displays the templates that meet your criteria.

   **Note:** In *eCard templates*, you can preview an eCard template to verify it is the one to copy. Under *eCard templates*, click the image of the template. A larger version of the image appears. To return to *eCard templates*, click the larger image.

4. Under **eCard templates**, click **Copy** under the template to edit. The *Add eCard template* screen appears.
5. In the **Name** field, the program adds “Copy of” to the name of the original eCard template. Enter a unique name so users can identify the new eCard template.

6. Edit the information as required to design the new eCard template. For information about how to design an eCard template, see [Design an eCard template on page 77](#).

7. Click **Save**. You return to **eCard templates**.

**Delete an eCard template**

1. From **Email**, click **eCard templates**. **eCard templates** appears.

2. Browse the Categories tab or click the Search tab to find the eCard template to delete.
3. The eCard templates frame displays the templates that meet your criteria.

**Note:** In eCard templates, you can preview an eCard template to verify it is the one to delete. Under eCard templates, click the image of the template. A larger version of the image appears. To return to eCard templates, click the larger image.

4. Under eCard templates, click Delete under the eCard template to delete. A confirmation message appears to verify the deletion of the template.

5. Click OK. You return to eCard templates. In the eCard templates frame, the template no longer appears.

**Design an eCard email message**

When you design an eCard email message, you can use merge fields to create a message that contains the content of the eCard or a link to a web page that contains the content. For information about the merge fields that appear for an eCard email message, see eCard Email Message Merge Fields on page 88.

1. From the Edit Part screen, click eCard email. The eCard Email screen appears.
Note: The screen shown above is the eCard Email screen for a Donation Form part. Depending on the part type you use, your eCard Email screen may differ slightly. Some eCard Email screens contain default text and merge fields. You can use the default text provided or enter different text.

2. Enter a name for the email and an email address and name to include in the From field of the email message.

Note: When you create an eCard template in eCard templates, you enter the subject line to appear for all eCard email messages that use the template.

3. To receive responses from recipients at a different email address than the one you use to send the message, click More Options and enter the address in the Reply Address field.

4. Under Notifications are to be sent to the following addresses, select Failures to receive failure messages when email messages are not delivered. In the field beside the checkbox, enter an email address to receive failure messages.

Note: Failures are email addresses that do not receive the acknowledgement email. Failures can also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status Notifications (DSN). For information about how the program handles failures, see Bounced Email Management on page 43.

5. In the box, enter the content to appear in the eCard email message. To format the email content’s appearance and layout, use the HTML editor.

To have information appear in the message that is specific for each eCard, sender, or recipient, click Merge fields on the Insert tab in the toolbar and select the merge fields to include in the message. For information about the merge fields that appear for an eCard email message, see eCard Email Message Merge Fields on page 88.

6. Click Save. You return to the Edit Part screen.
7. Click **Save**. You return to **Parts**.

### Sample eCard Templates

On the Samples tab, *eCard templates* provides sample eCard templates. You cannot edit these sample templates or select them for use on an eCard part or a Donation Form part. However, to save time, you can copy a sample template to design a new eCard template.

**Copy a sample template to design a new eCard template**

1. From *Email*, click **eCard templates**. *eCard templates* appears.
2. Select the Samples tab.

**Note:** In *eCard templates*, you can preview an eCard template to verify it is the one to copy. Under *eCard templates*, click the image of the template. A larger version of the image appears. To return to *eCard templates*, click the larger image.

3. Under *eCard templates*, click **Copy** under the sample template to edit. The Add eCard Template screen appears.

4. In the **Name** field, the program adds “Copy of” to the name of the sample eCard template. Enter a unique name so users can identify the new eCard template.
5. Edit the information as required to design the new eCard template. For information about how to design an eCard template, see Design an eCard template on page 77.

6. Click Save. You return to eCard templates.

**eCard Template Merge Fields**

When you design an eCard template, use merge fields to allow website users to personalize eCards based on the template with information specific to the sender or recipient. You can also use merge fields to create additional content that appears when a website user views a preview of the eCard or when the recipient views the sent eCard. To display the list of available merge fields, click **Merge fields** on the Insert tab in the toolbar of the Design tab. To expand the list, click the plus sign next to **eCard fields**. In addition to merge fields for donations and tributes, the merge fields specific to eCard templates appear.

- **Recipient’s name** – To display the name of the person that the website user sends the eCard to, add this merge field. For example, add “To: &lt;Recipient's name&gt;.”

- **Recipient’s email address** – To display the email address that the website user sends the eCard to, add this merge field. For example, add “To: &lt;Recipient's name&gt; (&lt;Recipient’s email address&gt;).”

- **Sender’s name** – To display the name of the website user who sends the eCard, add this merge field. For example, add “From: &lt;Sender's name&gt;.”

- **Sender’s email address** – To display the email address of the website user who sends the eCard, add this merge field. For example, add “From: &lt;Sender's name&gt; (&lt;Sender’s email address&gt;).”

- **Sender’s personal message** – To allow the sender to enter a personal message for the recipients, add this merge field. For example, add “Message: &lt;Sender's personal message&gt;.”

**Note:** To allow website users to send a personal message with eCards based on the template, you must include the &lt;Sender's personal message&gt; merge field. If you do not use this merge field on a template, the option to add a personal message does not appear when the user personalizes the eCard on your website.

- **Begin content for eCard preview** and **End content for eCard preview** – To include content to appear on the preview of an eCard that uses the template before the program sends it, use these merge fields to indicate when the preview content begins and ends.

**Tip:** If you require a donation for a user to send an eCard, you can use the **Begin content for eCard preview** and **End content for eCard preview** merge fields to display a watermark you create over the preview of the eCard. A watermark helps prevent users who attempt to avoid the donation and instead copy and send the free preview of the eCard.

- **Begin content for sent eCard** and **End content for sent eCard** – To include content to appear on each eCard sent that uses the template, use these merge fields to indicate when the sent content begins and ends. For example, you can include content about your organization and an invitation for the recipient to visit your website.

**Tip:** When you create content to appear for the recipient, you can include other merge fields within the **Begin content for sent eCard** and **End content for sent eCard** merge fields. For example, you can add “Do you want to send an eCard to &lt;Sender’s name&gt;?” with a link to your website’s eCard part page.
eCard Email Message Merge Fields

When you design an eCard email message, use merge fields to customize the message sent with information specific to the eCard and its sender and recipient. To display the list of available merge fields, click **Merge fields** on the Insert tab in the toolbar of the eCard Email screen. The merge fields specific to eCard email messages appear.

- **eCard name** – When you create an eCard template, you enter a name for the template. To display this name in the body of the message, use this merge field.
- **eCard content** – To display the personalized content of the eCard template in the body of the message, use this merge field.
- **eCard caption** – When you create an eCard template, you enter a caption for the template. To display this caption in the body of the message, use this merge field.
- **Email subject** – When you create an eCard template, you enter a subject line to appear for the email message that delivers the eCard. To include this subject in the body of the message, use this merge field.
- **Begin hyperlink to eCard** and **End hyperlink to eCard** – When the program sends an eCard, it generates a web page that contains its personalized content. To include a hyperlink to this web page in the body of the message, use these merge fields to indicate when the hyperlink begins and ends. The recipient can click this hyperlink to visit your website and view the content of the eCard.
- **Sender’s name** – To display the name of the website user who sends the eCard in the body of the message, add this merge field. For example, add “You have received an eCard from <Sender’s name>.”
- **Sender’s email address** – To display the email address of the website user who sends the eCard in the body of the message, add this merge field. For example, add “You have received an eCard from <Sender’s name> (<Sender’s email address>).”
- **Sender’s personal message** – To display the personal message the sender enters for the recipients in the body of the message, add this merge field. For example, add “Message from <Sender’s name>: <Sender’s personal message>.”
- **Recipient’s name** – To display the name of the person that the website user sends the eCard to, add this merge field. For example, add “Hello, <Recipient’s name>.”
- **Recipient’s email address** – To display the email address that the website user sends the eCard to, add this merge field. For example, add “Hello <Recipient’s name> (<Recipient’s email address>).”

Scheduled Emails

In Scheduled emails, you can create and schedule emails to send to selected constituents at specific times. For example, to send each alumnus an email during the month of the individual’s birthday, you must first create a birthday email template. For information about how to create an email template, see **Templates on page 15**. Then you create a list based on an offline constituent query that contains constituents who are alumni and whose date of birth equals this month. For information about how to
create a list, see Lists on page 66. The program merges the information in the list you selected with the merge fields in the birthday template. After you have a list and an email template, you can create a schedule for the process.

When you schedule an email, you determine how often you distribute the message. For messages that should be sent on a specific day, such as a particular holiday, you may want to schedule the email process to occur early in the morning so constituents receive the email on the same day. If you scheduled the process to run late at night, constituents may not receive the message until the following day.

**Note:** The time and time zone you select for the email process determine when the program sends the email job to the queue. It does not indicate when the messages will be sent. This is determined by the number of messages that have to be processed, the number of merge fields, and the number of existing email jobs that must process before your job can begin. For information about email status, see Email Delivery Status on page 44.

The email process runs on the scheduled day and time you select. If the list contains no records for the selected schedule, the program removes the scheduled job from the queue. If at any time you need to suspend a scheduled email, you can disable the schedule.

> **Create a scheduled email**

1. From Email, click Scheduled emails. Scheduled emails appears.
2. Click New scheduled email. The New scheduled email screen appears.

3. In Schedule name, enter a name for the scheduled email. This name appears in the Scheduled emails grid, so you can easily identify the process.
4. Click Enable schedule if you want the program to start the process at the time you select after you click Save. To create a scheduled email but not use the process immediately, do not select this checkbox.

**Tip:** You can use Enable schedule to temporarily suspend a scheduled email.
5. To select an email template for the process, click **Select template**. The template determines the merge fields and content that appear in the email message, as well as the recipient lists in the Select Target Lists screen.

   For information about how to create an email template, see **Templates on page 15**.

6. Click **Select list** to choose the list of recipients for this email.

   **Note:** Only lists that match the template’s data source type, such as a constituent query or an imported list, appear in the **Select list** field. For information about how to specify a data source for a template, see **Templates on page 15**.

   From the Select Target Lists screen, choose the list to use and click **Add** to move the entry to **Selected lists**. Click **OK** to return to the scheduled email screen.

7. Under **Create recurrence**, select a schedule for this email.

```
Create recurrence

Frequency of email:

- Daily
- Weekly
- Monthly
- Annually

Duration of scheduled email
 Start date:
 End date:

Scheduled email run-time
 Time to queue:
 Time zone:
```

8. Select a frequency of “Daily,” “Weekly,” “Monthly,” or “Annually.” You can then further define the schedule frequency. For example, if you select “Daily” you can choose to have the email process run on only weekdays.

9. In the **Duration of scheduled email** fields, define when to send the scheduled email. For example, to send weekly updates about an upcoming event, you can select a start date several months before the event and an end date for the day of the event.

   **Tip:** To always run the email process at the scheduled time, do not enter an end date.
10. In the **Scheduled email run-time** fields, enter the time for the program to queue the email job. Specify whether the time is a.m. or p.m.

11. In the **Time zone** field, select the time zone to use for the recurrence.

**Note:** The time and time zone you select determine when the program adds the scheduled email job to the queue. This time may be different than the time the email is sent to recipients.

12. Click **Save**. You return to **Scheduled emails**.

To view details about scheduled email jobs that have been processed, you can create an Email Activity Report. This report includes the date sent, the number of emails in the selected email job, the number of opened and bounced emails, and the number of page visits generated by each email.

For information about how to create an Email Activity Report, see the **Parts Guide**.

### Email Delivery and Deliverability

As email is an increasingly vital means of communication, the volume of messages email service providers (ESPs), such as Blackbaud, send to mailbox providers, such as Gmail or Yahoo!, is higher than ever. To help reduce the number of unwanted emails — sometimes referred to as **SPAM** — their users receive, mailbox providers use a combination of processes to evaluate messages.

Specifically, they consider the:

- ESP’s sending practices and reputation to determine whether to accept the **delivery** of a message.
- **Deliverability** of the message. Deliverability refers to how a mailbox provider determines where to place a message, such as in the recipient’s inbox or SPAM folder.

To determine **deliverability**, mailbox providers consider the:

- Recipient’s previous engagement with the sender’s messages, such as whether they opened them or clicked links
- Email’s design and composition
- Reputation of the sender’s domain

### Blackbaud’s Role in Delivery

As an email service provider (ESP), Blackbaud’s sending system is robust and scales well for clients both large and small. Since our system can send large numbers of messages simultaneously, we conform to standards for high-volume senders to ensure email **delivery**.

When you send an email, web services send information and email content to Blackbaud’s servers.

To process the messages, our servers:

- Validate email formats
- Remove addresses that meet suppression criteria
• Merge the remaining recipients' information and other merge fields with the content
The servers then use Mail Transfer Agent (MTA) software to transfer the processed messages from multiple shared Internet protocol (IP) addresses to mailbox providers. These servers can send millions of email messages per hour on even the heaviest of email volume days — such as Giving Tuesday and End of Year — and include configurations to automatically respond to the various tools and algorithms mailbox providers use to track and block senders who don't follow industry best practices.

We use this system in combination with a dedicated team of email specialists to help ensure your messages reach their intended recipients.

➤ Whitelists
Whitelists are lists of approved senders that mailbox providers maintain to recognize cooperative senders when they receive messages in large quantities.

Our email specialists coordinate and maintain our statuses on these lists across the major mailbox providers that use them to help increase the:
• Likelihood that messages reach their recipients
• Number and speed of emails we can send to them without triggering their SPAM filters
• Number of emails we can send to them before they return messages as "undeliverable" because they received too many messages at one time

➤ Blacklists
Blackbaud subscribes to ReturnPath — the email industry’s leading deliverability solution provider — to monitor external blacklists for our IP addresses. When necessary — such as on the rare occasions when SpamHaus or SpamCop list our IP addresses — our team of email specialists immediately request to delist them. We recommend you use services such as uribl.com to monitor your domain and, if necessary, request to de-list it.

For more information, see External Blacklists on page 93.

➤ Suppression lists
To maintain favorable reputations with mailbox providers, our system reviews recipient lists and automatically suppresses email addresses if previous messages resulted in:
• Delivery failures
• SPAM complaints
• Opt-outs

For more information, see Suppression Lists on page 93.

➤ Throttling
Some mailbox providers return messages as “undeliverable” or delay their delivery if an ESP tries to send too many emails at one time.
To avoid returned or delayed messages, our system uses a process known as *throttling* to restrict the number of concurrent connections it makes with mailbox providers to comply with their threshold specifications. Our email specialists continually monitor throttling limits and adjust our send rates as necessary — or as required — to ensure email performance.

**Shared IP addresses**

Mailbox providers evaluate the reputations of our system’s individual IP addresses when they determine message deliverability. An IP address’ reputation is the result of factors such as how frequently it sends messages and whether content engages recipients.

To help support positive sender reputations, our system enables clients to share IP addresses. When multiple clients use an IP address, they leverage the benefit of increased sending volume.

For more information see [Shared IP Addresses on page 94](#).

### External Blacklists

SPAM blacklists are domain and IP inventories of senders with poor reputations which sometimes help mailbox providers determine whether to place messages in recipient inboxes. Large trustworthy companies, as well as small, independent networks, create these lists and each provider uses them differently.

Typically, mailbox providers combine data from various public blacklists — as well as information from their own networks — to determine the credibility of a sender. Subsequently, many lists have little to no effect on IP reputation. Major providers disregard low-priority lists entirely and only use information from high-priority services such as SpamHaus and SpamCop.

Blackbaud subscribes to ReturnPath — the email industry’s leading deliverability solution provider — to monitor external blacklists for our IP addresses. When necessary — such as on the *rare* occasions when SpamHaus or SpamCop list our IP addresses — our team of email specialists immediately request to delist them. We recommend you use services such as [uribl.com](http://uribl.com) to monitor your domain and, if necessary, request to de-list it.

*Note:* Blacklist companies don’t block messages. Rather, mailbox providers use the listings as reasons for blocks. To prevent blocking, we recommend you manage your list quality and maintain a database of engaged recipients.

### Suppression Lists

To maintain favorable reputations with mailbox providers, our system reviews recipient lists and automatically suppresses email addresses for the following reasons:

- **Hard bounces** — When email delivery fails, mailbox providers send bounce code responses. The system categorizes and tracks these bounce codes so that it can suppress email addresses when they fail, such as when a recipient’s address is invalid or their account is closed.

- **SPAM complaints** — Our email specialists help maintain Feedback Loop (FBL) agreements with
mailbox providers that offer FBL programs. With an FBL agreement, a mailbox provider agrees to inform us when a recipient marks a message as unsolicited — such as when they select a “This is SPAM” button or link — so that our system can suppress their email address from future mailings from that sender.

**Note:** If the same email address appears in the recipient list for a mailing from another Blackbaud client, our system does not suppress it unless the recipient also marks the message from the other client as unsolicited.

- **Opt-out links** — When a recipient uses a legally required opt-out link in a message to request removal from emails, our system suppresses their address from future mailings specific to their request, such as only for a particular newsletter or all emails from an organization.

## Shared IP Addresses

Mailbox providers evaluate the reputations of our system’s individual IP addresses when they determine message deliverability. An IP address’ reputation is the result of factors such as how frequently it sends messages and whether content engages recipients.

To help support positive sender reputations, our system enables clients to share IP addresses. When multiple clients use an IP address, they leverage the benefit of increased sending volume.

The system also dynamically shifts senders between IPs as necessary to:

- Optimize delivery
- Prevent mailing practices of individual organizations from adversely impacting an IP’s reputation for others
- Help maintain email volume through each IP

➤ **IP designation**

To protect overall deliverability, the system calculates a SPAM complaint rate for you — based on information it receives from mailbox providers — and assigns you a grade to determine which IP addresses to send your mailings from.

To calculate the rate, the system counts how many complaints it received about your messages over the past 30 days and divides the number by how many emails you sent. The system updates the rate each night and uses the current average to assign your grade whenever you send a message.

When you manage the quality of your recipient lists and follow other deliverability recommendations, you are more likely to receive fewer SPAM complaints. A low SPAM complaint rate allows the system to assign you to IP addresses with higher reputations.

**Note:** Each quarter, our email specialists review how many messages the IP addresses send on average and adjust the SPAM complaint rate threshold for each grade as necessary. These changes help ensure our IP addresses share volume equally and send messages efficiently.

**Note:** Manual changes to sender grades are not supported because our system overrides updates as part of its automatic process.
Our email specialists closely monitor email practices and, if necessary, can intervene to disable service for a sender if they violate the Acceptable Use Policy and disrupt delivery for others.

Client's Role in Deliverability

Our email system is a conduit for you to communicate with individuals who show interest in your cause and request to receive email communications.

To maximize the effectiveness of the messages you send, it's critical to adhere to industry email best practices as outlined in Blackbaud’s Acceptable Use Policy. These guidelines protect your sender reputation and ours, which ultimately helps your emails reach recipient inboxes.

- **Manage list quality**
  
  For successful email campaigns, it’s essential to closely manage your current database of email addresses and use care as you identify and import new ones. Only send messages to individuals who opt in to receive your emails and who engage with the content you send them.

  For information about factors which impact email deliverability, see List Quality on page 96.

- **Engage email recipients**
  
  We trust — and expect — your organization to maintain a database of engaged recipients. We recommend you regularly review your data and group recipients into categories so you can determine whether to continue to send messages to them.

  For more information, see Engaged Recipients on page 97.

- **Avoid SPAM traps**
  
  A sender’s domain or IP address can appear on SPAM blacklists when they send messages to email addresses — known as SPAM traps — that are no longer active or not associated with a person.

  **Note:** Our Acceptable Use Policy requires you to only send messages to email addresses associated with people who opt-in to receive them. Our email specialists closely monitor email practices and, if necessary, can intervene to disable service for a sender if they violate this policy and disrupt delivery for others.

  For more information, see Spam Traps on page 97

- **Establish sender authentication**
  
  Mailbox providers use authentication methods to evaluate whether messages that appear to be from your organization are legitimate so they can block or filter email from fraudulent senders. To help them verify that you’re a legitimate sender, our email system supports multiple authentication methods for your domain. Since you own your domain, we rely on you to manage the authentication for it.
For more information, see Sender Authentication on page 98.

List Quality

For successful email campaigns, it’s essential to closely manage your current database of email addresses and use care as you identify and import new ones. Only send messages to individuals who opt in to receive your emails and who engage with the content you send them.

As you manage your data, closely consider the factors which impact email deliverability:

- Factors with a direct impact include:
  - **Invalid email addresses** — Old or improperly formatted email addresses result in hard bounces. Although our system subsequently suppresses these addresses, the initial attempts to send to them lower your reputation as a sender.
    
    **Note:** Since our system doesn’t know whether new email addresses are valid, we segregate them from the other addresses in recipient lists and use separate IPs — which are not associated with bulk mailings — to send to them. When delivery is successful, we approve the email addresses to join your regular list so you can use it in the next mailing.
    
    **Note:** We recommend you send welcome emails when new subscribers join your list so we can verify the addresses and provide them with an opportunity to add your “from” address to their list of approved senders. When you follow this best practice, you improve your chances of inbox placement.
  - **User engagement** — When recipients interact with the messages you send, mailbox providers are more confident about you as a sender and are more likely to deliver future messages to their inboxes.
    
    **Note:** Gmail — more so than other mailbox providers — relies on user feedback and engagement as their top measure to determine deliverability.
  - **SPAM complaints** — When you send emails to recipients who opt in to receive messages and who engage with your content, you keep the number of people who mark them as unsolicited to a minimum. The fewer complaints you receive, the more likely you are to have favorable reputations with mailbox providers.
  - **Sender authentication** — Mailbox providers use authentication methods such as SPF, DKIM, and DMARC to determine whether you are a legitimate sender. When you properly configure your sending domain for each method, your messages are more likely to reach recipient inboxes.

- Factors with an indirect impact include:
  - **Multiple ESPs** — We understand you may select multiple ESPs to send different types of email. However, if another ESP sends emails on your behalf and doesn’t adhere to the same high standards as Blackbaud, your reputation as a sender — even through our system — may suffer.
  - **High opt-outs** — When, over time, a large number of people request to no longer
receive email from you, mailbox providers are less likely to place your messages in recipient inboxes. To avoid these requests, use reports within your application to monitor whether recipients engage with your content and adjust your messages as necessary.

Engaged Recipients

We trust — and expect — your organization to maintain a database of engaged recipients.

We recommend you regularly review your data and group recipients into these categories so you can determine whether to continue to send messages to them:

- **Engaged** — Recipients who open or click links within messages you send.
- **Stale or inactive** — Recipients who do not open or click links within messages you send over an extended period, such as three to six months. Since recipients who do not engage with your content can lower your reputation as sender, consider strategies to re-engage them or remove them from your database.

Spam Traps

A sender's domain or IP address can appear on SPAM blacklists when they send messages to email addresses — known as SPAM traps — that are no longer active or not associated with a person.

**Note:** Our Acceptable Use Policy requires you to only send messages to email addresses associated with people who opt-in to receive them. Our email specialists closely monitor email practices and, if necessary, can intervene to disable service for a sender if they violate this policy and disrupt delivery for others.

There are three types of traps:

- **Recycled SPAM traps (RST)** — Include email addresses that are abandoned by recipients or retired by mailbox providers, then re-purposed to identify senders who continue to send to them.

  **Note:** A mailbox provider can convert an abandoned or retired address into a RST after just six months. After their pre-defined period of inactivity, they turn the account off and return hard bounce errors to senders — a process known as gravestoning — for 30 to 90 days. Some of those addresses are then reactivated and used as RSTs.

- **Pristine SPAM traps (PST)** — Include email addresses that are not associated with a person, but rather only exist to identify poor or malicious senders.

- **Role account (or function email account) traps** — Include email addresses with webmaster@, hostmaster@, sales@, support@, postmaster@, etc.

Depending on the type of trap and the mailbox provider, the penalty for being caught in a trap varies. Sometimes, providers will simply place messages from the senders they catch in SPAM folders. Other times, they will block all messages from the IP addresses that send them. Typically, Role Account (or Functional Email Account) traps result in higher penalties.

Do you wonder why Blackbaud’s email system doesn’t just suppress SPAM trap addresses? We wish we could. However, to prevent malicious senders from excluding RST and PST addresses from their lists,
the addresses seem legitimate. Unfortunately, we can’t identify them either, so we rely on clients to manage their data and only send to engaged recipients who opt-in to receive messages.

While we don’t recommend you purchase email lists — since they often contain SPAM trap addresses — we understand that sometimes you must. If so, we strongly encourage you to:

- Only purchase lists from reputable sources.
- Verify the last time a sender mailed to the email addresses. To reduce the likelihood that many are invalid, ensure they are less than six months old.
- Send an opt-in or subscription related message to confirm recipients are interested in additional messages.

Sender Authentication

Mailbox providers use authentication methods to evaluate whether messages that appear to be from your organization are legitimate so they can block or filter email from fraudulent senders. For example, a scammer could craft an email that looks like it comes from your organization and solicit donations to a site they own. If the mailbox provider can’t verify whether the email is from you, the scammer could receive gifts donors think they’re giving to your organization.

Fraudulent senders can change either of the “from” addresses an email message contains to make it seem like it’s from your organization:

- “Envelope from” — The return address — hidden in the message header — receiving mail systems use to return or bounce messages back to the sender.
- “Header from” — The friendly address — visible to email users — that appears in the From: field of an email.

To help mailbox providers verify when a sender is legitimate, our email system supports multiple authentication methods for your domain. Since you own your domain, we rely on you to manage the authentication for it.

**Note:** Mailbox providers use a variety of methods to evaluate messages, so passing or failing authentication checks doesn’t always directly correlate to inbox placement. We recommend you take a comprehensive approach to deliverability to increase the likelihood your messages reach recipients.

**Sender Policy Framework (SPF)**

The Sender Policy Framework (SPF) protocol is an authentication method that enables receiving mail systems to verify the mail servers that are authorized to send email on behalf of a domain.

When a mailbox provider uses SPF authentication, they compare the server that appears in the message header — also known as the long or internet header — to the sending servers that are listed in the Domain Name System (DNS) record for the “envelope from” address.

To authorize our system to send emails on your behalf, access the DNS record for your domain through your domain name registrar — such as GoDaddy, Network Solutions, or Name.com — and add the following to your TXT record for your SPF information:

**Note:** If your TXT record includes older entries such as include:outboundmail.blackbaudhost.com,
blackbaudemail.netcommunity1.com, or Blackbaud’s IP ranges, remove them.

**DomainKeys Identified Mail (DKIM)**

The DomainKeys Identified Mail (DKIM) protocol is an authentication method that digitally signs part of an email message so that receiving mail systems can verify it wasn’t altered after it was originally sent.

To use it, a sender decides which elements of a message they want to include for the signature — such as the header and body or individual fields in the header — and then configures their system to encrypt those selections with a private key when they send email. When a mailbox provider receives a message with a DKIM signature, they use the public key the sender lists for their domain in the DNS to “unlock” the private key.

**Note:** If you’d like to implement a DMARC policy, you can request a custom DKIM signature for your domain.

**Tip:** If your organization published DKIM public keys with less than 1024-bits, we recommend you delete them.

**Domain Message Authentication Reporting Conformance (DMARC)**

Since various ESPs might legitimately send messages on behalf of a domain, it can be difficult for a sender to know which of their messages authenticate properly with mailbox providers. To address this issue, Domain Message Authentication Reporting and Conformance (DMARC) provides a standard way for senders to establish policies for mailbox providers to use when email from them doesn’t pass SPF and DKIM.

The policies outline the criteria providers should use to determine whether messages pass or fail the checks and how they should handle messages that don’t pass, such as whether they should accept them, send them to the spam folder, or reject them entirely. The policies also detail the information mailbox providers should include in periodic reports to senders about which messages authenticate, which do not, and why.

To use DMARC, your organization must configure SPF and use a custom DKIM signature. We recommend you update all email servers that use your domain — such as the ones your organization uses locally — before you publish a DMARC policy. Given the complexity of this authentication method, and the significant impact improper configuration could have, we recommend you consult with your own email specialist before you implement it.

**Email Best Practices**

To ensure mailbox providers place your messages in recipient inboxes, and to improve engagement, we recommend you follow these best practices.
Communication Plans

Before you begin to compose your email, have a solid communication plan in place to ensure your messages are effective and well-received.

▶ Templates

Plan your templates so messages are consistent with your organization’s brand for external communications, including your website, but are distinct across different email campaigns. For example, use a consistent font within all email for a particular campaign to create a common identity across its messages. Keep the banner image short so links and content that drive recipients' participation occupy the majority of the preview pane of their mailbox providers.

**Note:** As many recipients will view your email through a mobile device, keep responsive design in mind as you develop email templates. With a responsive email template, your messages render appropriately across multiple devices and mailbox providers. For examples, see ZURB’s [Responsive Email Templates](http://www.zurb.com) and Email on Acid's [Free Responsive Email Template](http://www.emailonacid.com).

▶ Schedule

Over-communication can be as bad as non-communication. Plan your E-newsletter and email campaigns to ensure timely delivery of relevant information and an opportunity for interaction. To avoid delivery during business hours, do not send email messages between 8:00AM to 8:00PM. The best days to delivery email are during the middle of the week. Try regularly scheduled communications such as E-newsletters on different days until you determine which day is most effective.

▶ Recipient lists

To enable visitors to easily subscribe to E-newsletters and email campaigns, include a simple and efficient subscription form on your website. To ensure your communications are exactly as intended, test email messages with a list of internal recipients and seeds. To filter responses to a central monitored location, use a generic email address such as info@*.org as the ‘Reply-to’ address of your email messages. To determine the effectiveness of your recipient lists, check the delivery rate. If less than 80% of recipients receive your email, clean the list.

Email Content

As you compose the content of your email, follow these best practices to create subject lines and body copy that engage recipients.

▶ Subject line

You have at most 10 seconds to capture your recipients’ attention in the inbox, so keep the subject line...
descriptive and inviting, as well as concise and relevant, but not promotional. To help increase the likelihood that the recipient will open your message, follow these best practices:

- To ensure the recipient recognizes the sender, clearly identify your organization or known staff in the "From" line and address.
- Use no more than 25 characters so the entire subject line appears in the recipient's inbox, including on mobile devices.
- To avoid being mistaken for a duplicate message, update the subject line for each mailing, especially different mailings on the same topic.
- To avoid issues with content filters like SpamAssassin, don't use numbers or special characters, and avoid exaggerations such as ALL CAPS, overused exclamation points, and stars or dotted lines. Also, avoid terms such as "Free", "Apply now", "Extra cash", "Home-based", "Opportunity", "Limited time", "Money", and any words that may be considered pornographic.

**Note:** For an exhaustive list of words to avoid, see HubSpot's [The Ultimate List of Email SPAM Trigger Words](#).

- To analyze the effectiveness of your subject lines, check the open rate. If less than 25% of messages are opened, rework your subject lines.

### Calls to action

Your message should include at least one call to action — such as to donate, register, join, volunteer, or visit your website — that gives the recipient a compelling reason to act now. To increase the odds that the recipient responds in kind, follow these best practices:

- The call to action should be the focus of your email message. Start the message with a compelling call to action that is short enough to appear within the preview pane of the recipient's mailbox provider or mobile device.
- To ensure recipients see your call to action, style buttons as text and CSS so they appear regardless of whether the mailbox provider downloads your images.
- Use verbs and active voice with specific action-oriented language.
- As 70% of recipients click the first link, make that the most important call to action of your message.
- To analyze the effectiveness of your call to action, track the clickthrough rate of its link.

### Body copy

To retain your recipients' attention once they open the message, keep your content clear and concise, with no more than 250 words for total body copy. To make the most of those 250 words, follow these best practices as you compose your copy:

- Use email messages to introduce main content or functionality on your website. Rather than pack the message with lengthy copy full of details, include only the basics and point the audience to pages on your website.
For a monthly E-newsletter, point to a page with more information about each article and a donation page.

For an event announcement, point to a page with more information about the event and a registration page.

For a fundraising appeal, point to a donation page.

For a progress report on a mission, point to a slideshow of activities, a page with a summary of media mentions, a "tell-a-friend" page, and a donation page.

- Identify your organization by its specific name and location. In accordance with the United States’ Controlling the Assault of Non-Solicited Pornography and Marketing (CAN-SPAM) Act, include a link to your website and a contact phone number and email address.

- Avoid large graphics or pictures. Keep graphics minimal and sized to take up minimal space.

- Use headlines and bulleted lists to emphasize important points and allow recipients to quickly scan the content.

- To engage the recipient, use stories to share experiences and then use statistics, testimonials, case studies, and expert opinions to support the point.

- To grow relationships and response rates with recipients, use merge fields like <First name> to personalize the content.

- To avoid issues with content filters like SpamAssassin, avoid terms like "As seen on TV", "Call tollfree", "No obligation", "Limited time offer", "This is not spam", and "Earn extra".

- To communicate how you value recipients, invite them to update their profiles on your website.

- Keep your audience in mind. Provide content that is appropriate for the level of engagement and interest. To target different audience segments within the same communication, use dynamic content and segmentation.

- To analyze the effectiveness of the design of your copy, check the clickthrough rates to gauge engagement. Test with different colors and graphics until you see clickthrough rates improve.

- To analyze the length of your copy, check your unsubscribe requests. If you have a high rate of recipients who request to unsubscribe, you may be losing your audience with the amount of content.

Email Design

When you design a Hypertext Markup Language (HTML) email, remember that mailbox providers have developed slower than web browsers. Keep your design simple and rely on older HTML standards.

**Note:** To preview how your design renders across mailbox providers, use a testing service like Email on Acid.

**CSS**

As some mailbox providers remove the CSS from <head> and <body> tags, use inline CSS. Mailbox
providers may reject CSS shorthand, so declare each attribute of your elements separately.

**Note:** For an exhaustive look at which CSS style elements popular mailbox providers support, see Campaign Monitor's [CSS Support](https://www.campaignmonitor.com/css-support/). To quickly move existing CSS inline, use a conversion service such as [Premailer](https://www.premailer.io/).

#### Tables

Mailbox providers have poor support for `<float>`, `<margin>`, and `<padding>`, so use tables for layout. As you design your tables, follow these best practices:

- To set the width of a table, set the width of each of its cells rather than of the table itself. As mailbox providers have poor support for percentage-based widths, use pixels instead.
- To add padding to a cell, use either the `<cellpadding>` attribute of the table or a CSS padding for each cell, but not both. Or, nest tables rather than set margins or padding for table cells.
- Avoid whitespace between the `<td>` tags of your table, as mailbox providers may add padding above or below the cell contents.

#### Color

The use of color can help engage your audience and promote your organization's branding across email. As you design color in your HTML email, follow these best practices:

- Mailbox providers may ignore the `<background-color>` specified in your CSS or `<body>` tag, so use a container table for background colors. For example, nest your email content within a 100%-width table with a background color.
- Use longhand hexadecimal color values, as some mailbox providers may reject shorthand values.
- To prevent mailbox providers from overwriting your hyperlink colors with their default colors, set a default color inline for each link and then use a redundant span inside the `<a>` tag. For example:

```html
<a href="https://blackbaud.com/" style="color:#8cbe4f"> <span style="color:#8cbe4f">This is a hyperlink.</span> </a>
```

#### Images

As most mailbox providers block images by default, provide `<alt>` text for images so the recipient's first impression of your email isn't an empty placeholder or stripped image. The use of appropriate `<alt>` tags can increase recipients' trust in your message and the likelihood that they allow a mailbox providers to download your images. As you include images in your email, follow these best practices:

- Provide a background color to use with mailbox providers that don't support background images.
- Set the dimensions of your images so mailbox providers don't impose their own sizes for blocked images. Size images correctly before you add them to your content, as some mailbox providers rely on the true dimensions of the image instead of the dimensions specified in the
Email FAQs

FAQs- Email Processing

As an email service provider (ESP), Blackbaud’s sending system is robust and scales well for clients both large and small. Since our system can send large numbers of messages simultaneously, we conform to standards for high-volume senders to ensure email delivery.

Do your servers (MTAs) use TLS encryption?

All of our servers have TLS 1.2 encryption enabled. However, since not all receiving MTAs use TLS 1.2 to accept mail, our servers can switch to unencrypted when necessary. Otherwise, messages would fail authentication and not deliver to receiving servers that don’t use TLS 1.2.

What do I do if a bounce message says a message failed DMARC evaluation?

To use DMARC, your organization must configure SPF and use a custom DKIM signature. We recommend you update all email servers that use your domain — such as the ones your organization uses locally — before you publish a DMARC policy. Given the complexity of this authentication method, and the significant impact improper configuration could have, we recommend you consult with your own email specialist before you implement it.

If you receive a bounce message which indicates a message failed DMARC evaluation because neither DKIM or SPF aligned with the policy provided by the From domain, then you need to update the policy to include Blackbaud’s information.

What is a soft undeliverable email (soft bounce)?

If there’s a problem with an intended email address, the mailbox provider sends Blackbaud a code combination of numbers and text to indicate a soft or hard failure. We organize these codes into failure reason categories to help you understand and correct the problem. Soft failure categories include failure codes which aren’t permanent, such as mailbox full, inactive account, or network error. For more information, see Bounced Email on page 111.

What is a hard undeliverable email (hard bounce)?

If there’s a problem with an intended email address, the mailbox provider sends Blackbaud a code combination of numbers and text to indicate a soft or hard failure. We organize these codes into failure reason categories to help you understand and correct the problem. Hard failure categories
include failure codes which are permanent, such as unknown user, address error, or closed account. For more information, see Bounced Email on page 111.

What do email bounce messages and codes mean?
If there’s a problem with an intended email address, the mailbox provider sends Blackbaud a code combination of numbers and text to indicate a soft or hard failure. We organize these codes into failure reason categories to help you understand the problem and how to correct it. For more information, see Bounced Email on page 111.

Which email addresses are automatically suppressed from mailings?
To maintain favorable reputations with mailbox providers, our system reviews recipient lists and automatically suppresses email addresses for the following reasons:

- **Hard bounces** — When email delivery fails, mailbox providers send bounce code responses. The system categorizes and tracks these bounce codes so that it can suppress email addresses when they fail, such as when a recipient’s address is invalid or their account is closed.

- **SPAM complaints** — Our email specialists help maintain Feedback Loop (FBL) agreements with mailbox providers that offer FBL programs. With an FBL agreement, a mailbox provider agrees to inform us when a recipient marks a message as unsolicited — such as when they select a “This is SPAM” button or link — so that our system can suppress their email address from future mailings from that sender.

- **Opt-out links** — When a recipient uses an opt-out link in a message to request removal from future emails, our system suppresses their email address from future mailings specific to their request, such as only for a particular newsletter or all emails from an organization.

How can a sender remove a recipient’s email address from the suppression list?
To request that we remove an email address from the suppression list, the recipient must send a message from the affected address to unblockme@blackbaud.com and specifically request removal. In accordance with the United States’ Controlling the Assault of Non-Solicited Pornography and Marketing (CAN-SPAM) Act, we retain a copy of the request for our records. Future SPAM complaints from the recipient will return the address to the suppression list.

Can all blacklisted email addresses be removed at the same time?
No. To maintain favorable reputations with mailbox providers, our system reviews recipient lists and automatically suppresses email addresses for the following reasons:

- **Hard bounces** — When email delivery fails, mailbox providers send bounce code responses. The system categorizes and tracks these bounce codes so that it can suppress email addresses when they fail, such as when a recipient’s address is invalid or their account is closed.

- **SPAM complaints** — Our email specialists help maintain Feedback Loop (FBL) agreements with mailbox providers that offer FBL programs. With an FBL agreement, a mailbox provider agrees to
inform us when a recipient marks a message as unsolicited — such as when they select a "This is SPAM" button or link — so that our system can suppress their email address from future mailings from that sender.

To request that we remove an email address from the suppression list, the recipient must send a message from the affected address to unblockme@blackbaud.com and specifically request removal. In accordance with the United States’ Controlling the Assault of Non-Solicited Pornography and Marketing (CAN-SPAM) Act, we retain a copy of the request for our records. Future SPAM complaints from the recipient will return the address to the suppression list.

A message returned a soft bounce, will this be resent to the recipient automatically?

If our system receives a soft failure reason from a mailbox provider which could result in a successful delivery at a later time, the servers automatically attempt to resend the message up to five times over four hour time period. Examples of soft failures the system will resend include “mailbox full,” “too busy,” and “network error.” For more information, see Bounced Email on page 111.

How long does Blackbaud attempt to deliver emails before they are considered bounced?

If our system receives a soft failure reason from a mailbox provider which could result in a successful delivery at a later time, the servers automatically attempt to resend the message up to five times over four hour time period. Examples of soft failures the system will resend include “mailbox full,” “too busy,” and “network error.” For more information, see Bounced Email on page 111.

Where does Blackbaud’s system store the email data it collects?

Our system currently stores all email data on our secure servers.

Note: Canadian organizations subject to the Freedom of Information and Protection of Privacy Act (FIPPA) may be required to inform recipients that their personal data, such as from merge fields, is stored in the United States rather than in Canada.

How fast can Blackbaud’s system send email?

Each MTA server can send millions email messages per hour. We process email across multiple MTAs to allow our system to scale to meet sender email needs, even during periods of peak demand.

Where can I see Blackbaud’s sender reputation?

Since IP address information is public, you can use a number of websites to view Blackbaud’s sender reputation. The IP addresses we use to send bulk email include these ranges.

- 205.139.104.0/22 (205.139.104.1 - 205.139.107.254)
- 216.235.196.0/22 (216.235.196.1 - 216.235.199.254)
- 216.235.200.0/21 (216.235.200.1 - 216.235.207.254)
Note: There is no industry standard for measuring IP reputation, so results across different sources can differ dramatically.

FAQs — Email Best Practices

To ensure mailbox providers place your messages in recipient inboxes, and to improve engagement, we recommend you follow our recommended best practices.

What is an SPF record and how do I create it?

The Sender Policy Framework (SPF) protocol is an authentication method that enables receiving mail systems to verify the mail servers that are authorized to send email on behalf of a domain.

When a mailbox provider uses SPF authentication, they compare the server that appears in the message header — also known as the long or internet header — to the sending servers that are listed in the Domain Name System (DNS) record for the “envelope from” address.

To authorize our system to send emails on your behalf, access the DNS record for your domain through your domain name registrar — such as GoDaddy, Network Solutions, or Name.com — and add the following to your TXT record for your SPF information.

Note: If your TXT record includes older entries such as include:outboundmail.blackbaudhost.com, blackbaudemail.netcommunity1.com, or Blackbaud’s IP ranges, remove them.

What is DKIM and how do I add it?

The DomainKeys Identified Mail (DKIM) protocol is an authentication method that digitally signs part of an email message so that receiving mail systems can verify it wasn’t altered after it was originally sent.

To use it, a sender decides which elements of a message they want to include for the signature — such as the header and body or individual fields in the header — and then configures their system to encrypt those selections with a private key when they send email. When a mailbox provider receives a message with a DKIM signature, they use the public key the sender lists for their domain in the DNS to “unlock” the private key.

Note: If you’d like to implement a DMARC policy, you can request a custom DKIM signature for your domain.

Tip: If your organization published DKIM public keys with less than 1024-bits, we recommend you delete them.

How do I prevent my email from being marked as SPAM?

We encourage you to follow these deliverability recommendations.
How can I avoid my messages being considered SPAM by an anti-SPAM device?

Content filters like SpamAssassin score email content so mailbox providers can classify and filter unwanted messages. To avoid issues with them, create subject lines that don't use numbers or special characters, and avoid exaggerations such as ALL CAPS, overused exclamation points, and stars or dotted lines. Also, avoid terms such as “Free”, “Apply now”, “Extra cash”, “Home-based”, “Opportunity”, "Limited time", "Money", and any words that may be considered pornographic. Since anti-SPAM filters also assess message content after they review subject lines, use these same guidelines when you create the body of your emails.

We also recommend you review all of our email best practices.

Note: For an exhaustive list of words to avoid, see HubSpot's The Ultimate List of Email SPAM Trigger Words.

Which spammy words should I avoid in my subject lines or in the body of my emails?

For an exhaustive list of words to avoid, see HubSpot's The Ultimate List of Email SPAM Trigger Words.

FAQs — Email Delivery

Delivery refers to whether a mailbox provider accepts a message. Deliverability refers to how a mailbox provider determines where to place a message, such as in the recipient's inbox or SPAM folder.

Does Blackbaud resolve delivery issues such as blocks against a domain?

Our team of email specialists work to resolve most delivery issues. In the event an issue is the result of a sender's behavior, we work with the organization to help them improve their sending practices.

What is Blackbaud doing to prevent my email messages from being perceived as SPAM?

As an email service provider (ESP), we conform to standards for high-volume senders to ensure email delivery. We use our system in combination with a dedicated team of email specialists — who constantly monitor changes that occur within our system and throughout the industry — to help ensure your messages reach their intended recipients.

Why are my mailings and newsletters being marked as SPAM?

To prevent mailbox providers from considering your messages as SPAM, we encourage you to follow these deliverability recommendations.

Some of my recipients didn’t receive the mass email I sent. What happened?

Blackbaud’s servers send processed messages to our Mail Transfer Agent (MTA) servers, which
physically transmit messages using SMTP protocol to mailbox providers through multiple shared Internet protocol (IP) addresses. After our system transmits a file, the mailbox provider determines whether to accept it.

Specifically, they consider:

- Blackbaud’s sending practices and reputation to determine whether to accept the delivery of a message.
- The sender’s content to determine the deliverability of the message. Deliverability refers to how a mailbox provider determines where to place a message, such as in the recipient’s inbox or SPAM folder.

To determine deliverability, mailbox providers consider the:

- Recipient's previous engagement with the sender's messages, such as whether they opened them or clicked links
- Email’s design and composition
- Reputation of the sender’s domain

Sometimes, when we attempt to transmit a file, the server doesn't accept it and instead returns a soft or hard failure (bounce) code. We organize these codes into failure reason categories and include them with the bounce failure codes in reports to help you understand and correct problems. For more information, see Bounced Email on page 111.

Why didn’t people within my organization receive a message sent from our domain?

Since Blackbaud doesn’t control your organization's domain, email sent from your Blackbaud website is not technically sent from your @domain.org domain, even though you may have entered it in the “send as” or “send from” email address field. Email messages are actually sent from Blackbaud’s Mail Transfer Agent (MTA) servers. As a result, your receiving mail server may not recognize the domain.

To help mailbox providers — including the receiving mail server for your organization — verify that you are a legitimate sender, our email system supports multiple authentication methods for your domain. Since you own your domain, we rely on you to manage the authentication for it.

Also, to ensure your anti-SPAM systems don’t filter out email you send to yourself from our servers, we recommend you work with the administrator of your network’s email system to whitelist the following ranges of IP addresses.

- 205.139.104.0/22 (205.139.104.1 - 205.139.107.254)
- 216.235.196.0/22 (216.235.196.1 - 216.235.199.254)
- 216.235.200.0/21 (216.235.200.1 - 216.235.207.254)

Why don’t mailbox providers just bounce messages they think are SPAM instead of placing them in junk or SPAM folders?

When mailbox providers place messages they suspect are SPAM into recipient junk or SPAM folders,
they provide recipients with the opportunity to move them into their inbox and "unflag" them as junk. When users move messages to their inbox or click links within a message, larger mailbox providers such as Gmail rank those senders more favorably.

How does the email server at a recipient's organization judge whether an email is SPAM or not?
Deliverability refers to how a mailbox provider determines where to place a message, such as in the recipient's inbox or SPAM folder. To determine deliverability, mailbox providers consider the:

- Recipient's previous engagement with the sender's messages, such as whether they opened them or clicked links
- Email's design and composition
- Reputation of the sender's domain

To improve the likelihood that your messages reach recipient inboxes, we encourage you to follow these deliverability recommendations.

Which IP addresses does Blackbaud use to send email?
The IP addresses we use to send bulk email include these ranges.

- 205.139.104.0/22 (205.139.104.1 - 205.139.107.254)
- 216.235.196.0/22 (216.235.196.1 - 216.235.199.254)
- 216.235.200.0/21 (216.235.200.1 - 216.235.207.254)

What measures does Blackbaud take to avoid being blacklisted?
SPAM blacklists are domain and IP address inventories of senders with poor reputations which sometimes help mailbox providers determine whether to place messages in recipient inboxes. Large trustworthy companies, as well as small, independent networks, create these lists and each provider uses them differently.

Typically, mailbox providers combine data from various public blacklists — as well as information from their own networks — to determine the credibility of a sender. Subsequently, many lists have little to no effect on IP reputation. Major providers disregard low-priority lists entirely and only use information from high-priority services such as SpamHaus and SpamCop.

Blackbaud subscribes to ReturnPath — the email industry's leading deliverability solution provider — to monitor external blacklists for our IP addresses. When necessary — such as on the rare occasions when SpamHaus or SpamCop list our IP addresses — our team of email specialists immediately request to delist them. We recommend you use services such as uri!l.com to monitor your domain and, if necessary, request to de-list it.

**Note:** Blacklist companies don’t block messages. Rather, mailbox providers use the listings as reasons for blocks. To prevent blocking, we recommend you manage your list quality and maintain a database of engaged recipients.
How does Blackbaud handle external blacklisting?

Although we use measures to prevent external blacklisting, email senders’ practices ultimately determine the reputation of the shared IP addresses. If one of our IP addresses appears on a reputable blacklist, we take the corrective actions necessary to remove it.

Note: Some disreputable blacklist sites charge fees to remove IP addresses, only to add them back hours later. Mailbox providers don’t consider these blacklists valid, and neither does Blackbaud.

Bounced Email

When delivery of an email message fails, the mailbox provider sends our email system a code combination of numbers and text to indicate a soft or hard failure. We organize these codes into failure reason categories to help you understand and correct the problem.

- A hard bounce occurs when a mailbox provider rejects an email message, such as if the recipient email address does not exist.

  Note: To ensure a positive sender reputation, our system automatically suppresses email addresses that return hard bounces from future mailings. For more information, see Suppression Lists on page 93.

- A soft bounce occurs when an email message is processed by the recipient's mailbox provider but is returned as undeliverable before it reaches the recipient.

- A block failure occurs when an email recipient's mailbox provider intentionally refuses a message, such as if the sending IP address is on an external blacklist or the SPAM complaint rate for the sender is high.

- A technical failure occurs when delivery to an address or domain fails due to difficulties that occur during the attempt to connect with the recipient's mailbox provider.

Hard Bounce Failures

Hard bounce failures occur when email messages can never be delivered. These failures can occur for multiple reasons, such as address errors, bad domain names, unknown users, and closed accounts. To ensure a positive sender reputation, our system automatically suppresses email addresses that return hard bounces from future mailings. For more information, see Suppression Lists on page 93.

Unknown User

An email message may return a hard bounce failure if the email address is valid but the domain does not exist. This typically indicates that the account has been closed for some time. A hard bounce of Unknown User may indicate one of several conditions.

- Your mailing list may contain a high number of undeliverable records because it has not been mailed to recently or too much time as passed between the list capture and the mailing. This is
one of the main reasons by some major mailbox providers block incoming email. We recommend you adjust your mail frequency for customer preference and value and review all segments of the list on a regular basis to ensure brand visibility, the continuity of communication, and address delivery. To reduce the likelihood of a complaint, set standards to send first communications within five to 10 days after data capture. If you're mailing to an "old" segment, deploy the mailing slowly to avoid spikes in Unknown User failures.

- You may not adequately validate email addresses during data capture. We recommend you send follow-up email to new recipients to confirm opt-in permission and validate delivery to the address. If email bounces for reasons that indicate an invalid or inactive email account, remove the address and contact the recipient for new or updated email address information. To minimize typographical errors, we recommend you require double-entry of email addresses during online registration or opt-in. We also recommend you perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list and then send a confirmation email to corrected addresses.

- For a high incidence of stale, inaccurate, or fictitious data, you may have unreliable data sources such as from a list rental or affiliate. We recommend you investigate the data compilation and management practices of your data sources and confirm consent and delivery before you add third-party names to a list. We also recommend you contact recipients for new or updated email address information and perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list, then end a confirmation email to corrected addresses.

**Bad Domain**

An email message may return a hard bounce failure if the email address has a domain that is invalid or does not exist. A hard bounce of Bad Domain may indicate one of several conditions.

- Your mailing list may contain a high number of undeliverable records because it has not been mailed to recently or too much time as passed between the list capture and the mailing. This is one of the main reasons by some major mailbox providers block incoming email. We recommend you adjust your mail frequency for customer preference and value and review all segments of the list on a regular basis to ensure brand visibility, the continuity of communication, and address delivery. To reduce the likelihood of a complaint, set standards to send first communications within five to 10 days after data capture. If you're mailing to an "old" segment, deploy the mailing slowly to avoid spikes in Unknown User failures.

- You may not adequately validate email addresses during data capture. We recommend you send follow-up email to new recipients to confirm opt-in permission and validate delivery to the address. If email bounces for reasons that indicate an invalid or inactive email account, remove the address and contact the recipient for new or updated email address information. To minimize typographical errors, we recommend you require double-entry of email addresses during online registration or opt-in. We also recommend you perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list and then send a confirmation email to corrected addresses.

- For a high incidence of stale, inaccurate, or fictitious data, you may have unreliable data sources
such as from a list rental or affiliate. We recommend you investigate the data compilation and management practices of your data sources and confirm consent and delivery before you add third-party names to a list. We also recommend you contact recipients for new or updated email address information and perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list, then end a confirmation email to corrected addresses.

➤ Address Error

An email message may return a hard bounce failure if the email address has a format or syntax error, such as multiple or missing "@" sign. A hard bounce of Address Error may indicate one of several conditions.

- You may not adequately validate email addresses during data capture. We recommend you send follow-up email to new recipients to confirm opt-in permission and validate delivery to the address. If email bounces for reasons that indicate an invalid or inactive email account, remove the address and contact the recipient for new or updated email address information. To minimize typographical errors, we recommend you require double-entry of email addresses during online registration or opt-in. We also recommend you perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list and then send a confirmation email to corrected addresses.

- For a high incidence of stale, inaccurate, or fictitious data, you may have unreliable data sources such as from a list rental or affiliate. We recommend you investigate the data compilation and management practices of your data sources and confirm consent and delivery before you add third-party names to a list. We also recommend you contact recipients for new or updated email address information and perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list, then end a confirmation email to corrected addresses.

➤ Closed Account

An email message may return a hard bounce failure if the email address is valid for the domain but is now closed or suspended. A hard bounce of Closed Account may indicate one of several conditions.

- The recipient may have changed the email address. You should contact the recipient for new or updated email address information. As a best practice, we recommend you maintain good list hygiene and mailing practices and request new or additional email addresses from its recipients as part of its data capture and ongoing communications.

- For a high incidence of stale, inaccurate, or fictitious data, you may have unreliable data sources such as from a list rental or affiliate. We recommend you investigate the data compilation and management practices of your data sources and confirm consent and delivery before you add third-party names to a list. We also recommend you contact recipients for new or updated email address information and perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list, then end a confirmation email to corrected addresses.
Soft Bounce Failures

Soft bounce failures occur when email messages are processed by recipient mailbox provides but are returned as undeliverable before they reach their recipients.

➤ Mailbox Full

An email message may return a soft bounce failure if the recipient’s mailbox is full or exceeds its maximum storage. A soft bounce of Mailbox Full may indicate one of several conditions.

Note: By default, our system automatically includes an email address on the suppression list as a hard bounce after three Mailbox Full soft bounce failures.

- The recipient may have received an unusually high volume of email, or may not have checked email in a while due to vacation or travel. We recommend you attempt to resend the message and monitor its acceptance status.
- As consumers average three separate email accounts, a Mailbox Full failure may signify an email account of lesser importance. We recommend you attempt to contact the recipient through alternate means to request new or updated email address information.
- The recipient may have abandoned the email address. We recommend you monitor for a hard bounce failure of Closed in response to future mailings. If this occurs, you should contact the recipient through alternate means to request new or updated email address information.

➤ Inactive or Disabled Account

An email message may return a soft bounce failure if the recipient’s account is inactive or temporarily disabled. A soft bounce of Inactive/Disabled Account may indicate one of several conditions.

Note: By default, Blackbaud Communication Services automatically promotes an email address to the blacklist as a hard bounce after three Inactive/Disabled Account soft bounce failures.

- The recipient may not have paid the subscription fee or is involved in a dispute with the mailbox provider. We recommend you attempt to resend the message and monitor its acceptance status.
- The recipient may not have checked email in a while due to vacation or travel. We recommend you attempt to resend the message and monitor its acceptance status.
- The mailbox provider may have flagged the account as inactive due to lack of use, or the recipient may have abandoned the email address. We recommend you monitor for a hard bounce failure of Closed in response to future mailings. If this occurs, you should contact the recipient through alternate means to request new or updated email address information.

➤ Greylist

An email message may return a soft bounce failure if it has been greylisted. The greylist is a temporary block used by smaller ISPs and corporate domains to combat SPAM. When a message is greylisted, the recipient’s mail server does not reject the message; instead, it tests to see if the sender will attempt
delivery again as a means to filter out SPAM. We recommend you attempt to resend the message and monitor its acceptance status.

**Note:** By default, our system automatically includes an email address on the suppression list as a hard bounce after three Greylist soft bounce failures.

### Block Failures

A block failure occurs when an email recipient's mailbox provider intentionally refuses a message. For example, the mailbox provider may refuse the connection, refuse to accept the email during the connection, or return the email as undelivered after several delivery attempts. Block failures may occur for multiple reasons, such as if the sending IP address is on an external blacklist or the SPAM complaint rate for the sender is high.

**Note:** This may be the result of other mailings sent from other clients and not directly related to the one you sent. However, if you see these types of failures, please note the best practices we recommend to minimize them in future mailings.

#### SPAM Complaint

An email message may return a block failure if the recipient flags email sent through the IP address as SPAM. A block failure of SPAM Complaint may indicate one of several conditions.

- The recipient may not be actively engaged with your organization, as evident through no or low opens or clicks. **Inactivity directly correlates to SPAM complaints.** We recommend you attempt to engage inactive recipients with a separate reactivation mailing and purge non-respondents from your lists. To create this mailing, identify inactive recipients who have not opened or clicked in mailings over the past six months and then send those recipients messages over the next 30 days to remind them of the relationship and allow for recipients to opt out of future email. After the 30 day window, send recipients with no open or click activity one final "Sorry to see you go" message that allows them to opt in, and then remove them from mailing lists.

- You may email the recipient too frequently or not frequently enough. If you email too frequently, the recipient may identify the email as SPAM. If you email too infrequently, the mailing may not cause the recipient to remember giving you permission to send to them. We recommend you review the frequency of your mailings and adjust it as necessary to be consistent with recipient expectations. You should also offer recipients a choice on both frequency and content and then verify recipients understand what they sign up to receive, including the frequency of when to expect email.

- The email message may not target its recipients appropriately, or its content is not relevant to the recipient's preferences. We recommend you provide sample email for recipients to review during the sign-up process and allow them to update their profiles with information used to increase the content's relevance.

- The recipient may not associate the email with your organization due to poor branding. We recommend you use consistent, prominent branding in the 'From' address, 'From' name, and
subject line.

- The recipient may not associate the email with permission granted to your organization, a third-party you use for list rental, or an affiliate program. We recommend you use explicit methods to obtain and disclose permissions, such as through a double opt-in feature. To remind recipients of why they receive messages, you should prominently display permission statements in the mailings to explain that recipients subscribed to the mailing list. You should also reconfirm the permission or track other indicators of sustained interest such as responses and donations. We recommend you also investigate permission practices of affiliates and send follow-up messages to recipients to confirm consent before you add third-party names in lists.

- The recipient may assume the mailing is the same as a similar mailing they have already opted out of. We recommend you create email campaigns and newsletters around distinct topics to help recipients identify which they want. You should also properly design email and enewsletter templates to handle opt-outs for specific messages and campaigns in the proper hierarchy.

**Blacklist**

An email message may return a block failure if its domain name or IP address appears on an external blacklist. A block failure of Blacklist may indicate one of several conditions.

- The message may have generated a high rate of SPAM complaints.
- The recipient email address may be a SPAM trap. SPAM traps are email addresses that once belonged to recipients but were closed or intentionally published on websites. Rather than reissue the addresses to recipients, mailbox providers mark them as traps to identify senders who attempt to send messages to them. We recommend you know your data sources and keep your list management practices current and active. You should investigate how third parties or affiliates compile and manage their lists. We also recommend you clean your mailing lists as part of your normal email management practices and send messages to recipients to confirm consent before you add third-party names in lists. For more information, see Spam Traps on page 97.

**Note:** To help prevent delivery to SPAM traps, our system automatically suppresses known bad email addresses.

- The recipient may assume the mailing is the same as a similar mailing they have already opted out of. We recommend you create email campaigns and newsletters around distinct topics to help recipients identify which they want. You should also properly design email and enewsletter templates to handle opt-outs for specific messages and campaigns in the proper hierarchy.

**ISP Block**

An email message may return a block failure if its domain name or IP address appears on a blacklist. A block failure of ISP Block may indicate one of several conditions.

- The message may have generated a high rate of SPAM complaints.
- The message may have generated a high rate of failures associated with SPAM or poor list management practices.
Content Block
An email message may return a block failure if some aspect of its content triggers a SPAM filter, such as due to prohibited words or phrases or too many HTML tags, images, or font styles, sizes, or colors. We recommend you send your content through a SPAM score test. Based on the score, you can then assess your email templates and adjust the templates, style, and HTML as necessary.

Note: There are hundreds of SPAM filters, and most have low penetration and no appreciable impact on email delivery. Others may have broader impact depending on usage at the domains on your mailing list. Mailbox providers now rely less on content blocks and instead use other factors, such as the sender's overall reputation, to determine whether to accept email and deliver it to the recipient's inbox or junk mail folder.

URL Block
An email message may return a block failure if a URL in the email is associated with SPAM complaints. A block failure of URL Block may indicate one of several conditions.

- You may use URLs too broadly, or the practices your affiliates may impact your reputation. We recommend you use distinct URLs for each type of mail, such as transactional and bulk. You should also investigate the underlying issue with the URL to verify it's not used in other email perceived as SPAM.

- The recipient may not be actively engaged with your organization, as evident through no or low opens or clicks. Inactivity directly correlates to complaints. We recommend you attempt to engage inactive recipients with a separate reactivation mailing and purge non-respondents from your lists. To create this mailing, identify inactive recipients who have not opened or clicked in mailings over the past six months and then send those recipients messages over the next 30 days to remind them of the relationship and allow them to opt out of future email. After the 30 day window, send recipients with no open or click activity one final "Sorry to see you go" message that allows them to opt in, and then remove them from mailing lists.

- You may email the recipient too frequently or not frequently enough. If you email too frequently, the recipient may identify the email as SPAM. If you email too infrequently, the mailing may not cause the recipient to remember giving you permission to send to them. We recommend you review the frequency of your mailings and adjust it as necessary to be consistent with recipient expectations. You should also offer recipients a choice on both frequency and content and then verify recipients understand what they sign up to receive, including the frequency of when to expect email.

- The email message may not target its recipients appropriately, or its content is not relevant to the recipient's preferences. We recommend you provide sample email for recipients to review during the sign-up process and allow them to update their profiles with information used to increase the content's relevance.

- The recipient may not associate the email with your organization due to poor branding. We recommend you use consistent, prominent branding in the 'From' address, 'From' name, and subject line.

- The recipient may not associate the email with permission granted to your organization, a third-
party you use for list rental, or an affiliate program. We recommend you use explicit methods to obtain and disclose permissions, such as through a double opt-in feature. To remind recipients of why they receive messages, you should prominently display permission statements in the mailings to explain that recipients subscribed to the mailing list. You should also reconfirm the permission or track other indicators of sustained interest such as responses and donations. We recommend you also investigate permission practices of affiliates and send follow-up messages to recipients to confirm consent before you add third-party names in lists.

- The recipient may assume the mailing is the same as a similar mailing they have already opted out of. We recommend you create email campaigns and newsletters around distinct topics to help recipients identify which they want. You should also properly design email and e-newsletter templates to handle opt-outs for specific messages and campaigns in the proper hierarchy.

**Excess Traffic**

An email message may return a block failure if the email volume exceeds the limits or capacity of the recipient’s mailbox provider.

To avoid returned or delayed messages, our system uses a process known as throttling to restrict the number of concurrent connections it makes with mailbox providers to comply with their threshold specifications. Our email specialists continually monitor throttling limits and adjust our send rates as necessary — or as required — to ensure email performance.

**Security Violation or Virus**

An email message may return a block failure because of a security policy violation. A block failure of Security Violation/Virus may indicate one of several conditions.

- The recipient’s mailbox provider may not be able to verify your organization’s identifying information using authentication methods such as SPF or DKIM. For more information, see Sender Authentication on page 98.

- Your cumulative daily volume may exceed the number of emails allowed the limits set by smaller domains to protect servers from SPAM. We recommend you determine the percentage of the email blocked and importance of recipients at the domain. If necessary, distribute the volume over multiple days.

**List Management**

An email message may return a block failure if Unknown User hard bounce failures reach an unacceptably high level. A block failure of List Management may indicate one of several conditions.

- Your mailing list may contain a high number of undeliverable records because it has not been mailed to recently or too much time as passed between the list capture and the mailing. This is one of the main reasons by some major mailbox providers block incoming email. We recommend you adjust your mail frequency for customer preference and value and review all segments of the list on a regular basis to ensure brand visibility, the continuity of communication, and address delivery. To reduce the likelihood of a complaint, set standards to
send first communications within five to 10 days after data capture. If you're mailing to an "old" segment, deploy the mailing slowly to avoid spikes in Unknown User failures.

- You may not adequately validate email addresses during data capture. We recommend you send follow-up email to new recipients to confirm opt-in permission and validate delivery to the address. If email bounces for reasons that indicate an invalid or inactive email account, remove the address and contact the recipient for new or updated email address information. To minimize typographical errors, we recommend you require double-entry of email addresses during online registration or opt-in. We also recommend you perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list and then send a confirmation email to corrected addresses.

- For a high incidence of stale, inaccurate, or fictitious data, you may have unreliable data sources such as from a list rental or affiliate. We recommend you investigate the data compilation and management practices of your data sources and confirm consent and delivery before you add third-party names to a list. We also recommend you contact recipients for new or updated email address information and perform address hygiene to correct common misspellings on major domains before you add large quantities of addresses to your list, then end a confirmation email to corrected addresses.

**Authentication**

An email message may return a block failure of Authentication if the recipient's mailbox provider can't verify your organization's identifying information using authentication methods such as SPF or DKIM. For more information, see [Sender Authentication on page 98](#).

**Technical Failures**

Email delivery to an address or domain may fail due to technical difficulties that occur during the attempt to connect with the recipient’s mailbox provider. Technical failures may occur for multiple reasons, such as a down server, overloaded conditions, and network or DNS errors. We recommend you examine the type of technical failure to determine its cause. If an email address returns the same failure in response to mailings over 30 days, you should invalidate the address and contact the recipient for new or updated email address information.

**Too Busy**

An email message may return a technical failure if the recipient’s mailbox provider is temporarily overwhelmed with delivery attempts. We recommend you attempt to send the email again later and monitor the acceptance status.

*Note:* By default, our system automatically includes an email address on the suppression list as a hard bounce after three Too Busy soft bounce failures.

**Data Format Error**

An email message may return a technical failure if the recipient's mailbox provider rejects it due to
formatting issues. A technical failure of Data Format Error may indicate one of several conditions.

**Note:** By default, our system automatically includes an email address on the suppression list as a hard bounce after three Data Format Error soft bounce failures.

- The subject line of the message may exceed the length restrictions of the recipient’s mailbox provider. We recommend you shorten the subject line as necessary and then retry delivery.
- The header of the message may be incorrectly formatted, or the body of the message contains prohibited formatting or characters. For example, smaller mailbox providers may not accept foreign language characters. We recommend you review the “From” email address, subject, and message content for unusual formatting or characters and then retry delivery after clean-up.

**Network Error**

An email message may return a technical failure if the connection to the recipient’s mail server is lost during delivery. A technical failure of Network Error may indicate that the mailbox provider’s server may have gone down or timed out, or there may have been routing issues between our system and the provider. We recommend you attempt to send the email again later and monitor the acceptance status.

**Note:** By default, our system automatically includes an email address on the suppression list as a hard bounce after three Network Error soft bounce failures.

**Other Error**

An email message may return a failure due to technical reasons that are typically low incidence and cannot be interpreted or categorized based on feedback from the recipient’s mailbox provider. These may occur due to new bounce codes implemented by the provider that have not yet been categorized. If new bounce codes occur, our system attempts to categorize them for future mailings.

**Note:** By default, our system automatically includes an email address on the suppression list as a hard bounce after three Other Receiver Error soft bounce failures.